Contents

Getting Started ................................................................................................................ 1
  Welcome ....................................................................................................................... 1
  Using This Guide ........................................................................................................... 2
    Guide Structure .......................................................................................................... 2
    Individual and Corporate Plan Users ......................................................................... 2
    Mac Users .................................................................................................................. 2
  System Requirements ................................................................................................... 3
  Terms ............................................................................................................................ 5
  Product Features ........................................................................................................... 6

Install GoToMeeting ........................................................................................................... 7
  Create Your Organizer Account - Individual Organizers ............................................... 7
  Create Your Organizer Account - Corporate Plan Users .............................................. 7
  Install GoToMeeting ...................................................................................................... 8
  Upgrade to GoToMeeting with HDFaces ...................................................................... 9
  The GoToMeeting Application ..................................................................................... 11
  Preferences for PC Users ........................................................................................... 12
    Start Up Preferences ............................................................................................... 12
    General Preferences ............................................................................................... 13
    Meetings Preferences .............................................................................................. 13
    Recording Preferences ............................................................................................ 14
    Integration Preferences ............................................................................................ 15
    Connection Preferences ........................................................................................... 15
    Audio Preferences ................................................................................................... 16
    Webcam Preferences .............................................................................................. 16
  Preferences for Mac Users ........................................................................................ 17
  GoToMeeting Outlook Toolbar .................................................................................... 18
  GoToMeeting Lotus Notes Menu Options ................................................................... 19
  GoToMeeting Messenger Button ................................................................................ 20
  Add a GoToMeeting Corporate "Meet Now" Button to Your Website ......................... 20
  Set Up GoToMeeting for Use with Citrix Presentation Server ..................................... 22

Organize Meetings ........................................................................................................... 25
Organizer Role Overview ............................................................................................ 25
Schedule a Meeting .................................................................................................... 26
  Schedule a Meeting from Your Desktop................................................................. 26
View Scheduled Meetings ....................................................................................... 27
Schedule Recurring Meetings ............................................................................... 28
Schedule International Meetings ........................................................................... 29
View Scheduled Meetings ....................................................................................... 31
Invite Attendees to a Scheduled Meeting.............................................................. 32
Edit a Scheduled Meeting...................................................................................... 33
Expired Meetings......................................................................................................... 34
  Cancel a Scheduled Meeting............................................................................... 35
Set GoToMeeting Time Zone.................................................................................... 36

Mobile Devices .............................................................................................................. 37
  GoToMeeting App for iPad, iPhone & iPod Touch FAQs ........................................... 37
  GoToMeeting App for Android FAQs ....................................................................... 41
  General Information.................................................................................................. 41
  Troubleshooting FAQs............................................................................................ 42

GoToMeeting Integrated Audio ...................................................................................... 43
  Audio Mode: Using Telephone.................................................................................... 44
    Turning entry and exit chimes on/off ...................................................................... 44
  Audio Mode: Using VoIP Checklist .......................................................................... 45
  Mic & Speakers Device Recommendations ............................................................ 45
  Mic & Speakers Setup - PC Users .......................................................................... 46
  Audio Hardware Detection....................................................................................... 47
  Mic & Speakers Setup - Mac Users......................................................................... 47
  Entry/Exit Chimes and On-Hold Beeps ................................................................... 48
  Integrated Toll-Free Audio ...................................................................................... 49
    Calculating Toll-Free Minutes .............................................................................. 49
    Schedule a Meeting with Integrated Toll-Free Audio .............................................. 50
    Schedule a Meeting with Toll-Free and VoIP .......................................................... 51
    Start a Meeting with Integrated Toll-Free Audio..................................................... 51
    Countries with Integrated Toll-Free Audio ............................................................ 51
    Recording with Toll-Free Audio ........................................................................... 52
Toggle Audio Notifications .......................................................................................... 52
Broadcast Computer Audio.......................................................................................... 53
Hardware Option........................................................................................................... 53
3rd Party Audio and HiDef Conferencing ................................................................. 54
Citrix Online HiDef Conferencing™ ........................................................................ 54

HDFaces Video Conferencing .................................................................................. 55
Share or stop webcams from the Control Panel...................................................... 55
Manage your webcam from your video feed ......................................................... 56
Toggle the webcam layouts....................................................................................... 57
Remove webcams for all participants...................................................................... 58
Manage your webcam settings.................................................................................. 58

Start/End a Scheduled Meeting.............................................................................. 59
Start a Scheduled Meeting from Your Desktop ...................................................... 59
Start a Meeting from the Web................................................................................... 60
Start a Meeting from Outlook................................................................................... 60
Start a Meeting from IBM Lotus Notes ................................................................. 61
Start a Meeting from Microsoft Office .................................................................... 61
Start an Impromptu Meeting..................................................................................... 62
Leave or End a Meeting............................................................................................ 64

The Organizer/Presenter Control Panel............................................................... 65
Screen Sharing Pane.................................................................................................. 66
Share Your Desktop................................................................................................... 66
Pass Roles to Attendees............................................................................................. 67
Request Keyboard and Mouse.................................................................................... 67
Manage Attendees ...................................................................................................... 68
Manage Audio............................................................................................................ 69
Audio PIN................................................................................................................... 69
Attendees Audio........................................................................................................ 69
On-Hold Beeps and Entry/Exit Chimes .................................................................... 70
Audio Control Icons.................................................................................................. 71
Organizer Audio......................................................................................................... 72
Muting Audio.............................................................................................................. 74
Chat with Attendees................................................................................................. 75
Invite Attendees During a Meeting ................................................................. 76
Grab Tab ........................................................................................................... 77
   Drawing Tools .............................................................................................. 78
   Choose Pen Color ......................................................................................... 79
Menu Bar - PC Users ....................................................................................... 80
Toolbar - Mac Users .......................................................................................... 81

Record and Play a Meeting ............................................................................. 82
   Notes on Recording and Playing a Meeting .................................................. 82
   Record a Meeting ........................................................................................... 83
   Play a Recorded Meeting ............................................................................ 86
   Distribute a Recorded Meeting ................................................................... 87
   Edit a Recorded GoToMeeting Recording .................................................. 88
      Re-encode with Expression Encoder ......................................................... 88
   Locate a Recorded GoToMeeting, GoToWebinar or GoToTraining ............ 89
   Download Windows Media Player ............................................................... 90

Attending Meetings ......................................................................................... 91
   Attendee Role Overview .............................................................................. 91
   Join a Meeting ............................................................................................... 91
   Attendee Viewer and Control Panel .............................................................. 93
   Attendee Control Panel ............................................................................... 94
      Attendee Control Panel Menu Bar - PC Users ........................................ 95
      The Attendee Toolbar - Mac Users ............................................................ 96
   Attendee Control Panel Grab Tab ................................................................. 97
   Attendee Drawing Tools .............................................................................. 98
   Chat with Other Attendees ......................................................................... 99
   Attendee Viewer Window .......................................................................... 100
   Share Presenter Mouse and Keyboard ......................................................... 101
   Become a Presenter ...................................................................................... 102
   Become an Organizer .................................................................................. 102
   Leave a Meeting .......................................................................................... 103

The GoToMeeting Organizer Web Site .......................................................... 104
   Log In to Your Organizer Website ............................................................. 104
   My Account .................................................................................................. 104
GoToMeeting® User Guide

Change Account Password ............................................................................................ 105
Audio Settings .............................................................................................................. 106
Cancel Your Account or Update Billing Information (Individual Only) ..................... 106
  Renew or Cancel GoToMeeting (Individual Only) .................................................... 107
  Is Updating Credit Card Information Secure? .......................................................... 107
Cancel Your GoToMeeting Account ............................................................................ 108
Plan Selection (Individual Only) ................................................................................ 110
View Account History (Individual Only) ..................................................................... 111
My Meetings ................................................................................................................ 112
  View Scheduled Meetings Online .......................................................................... 112
  View Meeting History .............................................................................................. 113
Tips for Success .......................................................................................................... 114
  Prior to Meeting or Event Start .............................................................................. 114
  Managing the Meeting ............................................................................................. 114
  Managing the Conference Call ............................................................................... 114
Using GoToMeeting with a Firewall .......................................................................... 115
  Configure your Firewall .......................................................................................... 115
  Locating GoToMeeting Files .................................................................................. 116
    32-bit or 64-bit Windows PCs .............................................................................. 116
  Enabling GoToMeeting with McAfee® Anti-virus Software .................................... 116
    McAfee Total Protection ....................................................................................... 117
  Enabling GoToMeeting with Norton® Anti-virus Software ...................................... 119
    Norton Internet Security 2010 .......................................................................... 119
    Norton 360 3.0 .................................................................................................. 120
  Enabling GoToMeeting with Kaspersky® Anti-virus Software ................................. 122
    Kaspersky Anti-Virus 2010 .............................................................................. 122
    Additional Firewall Resources ............................................................................. 124
Troubleshooting and FAQs ......................................................................................... 125
  General GoToMeeting FAQs ............................................................................... 125
  HDFaces Video Conferencing FAQs .................................................................... 129
  HDFaces Video Conferencing Troubleshooting FAQs ............................................ 132
  Troubleshooting GoToMeeting with a Firewall ....................................................... 133
  Audio FAQs .......................................................................................................... 135
Mac OS X 10.7 Lion FAQs ................................................................. 140
Integrated Toll-Free FAQ ................................................................. 143
Recording FAQs .................................................................................. 145
Troubleshoot Recording and Replaying a Meeting ................................ 147
Citrix Presentation Server FAQs ......................................................... 147
Connection Test Help ........................................................................... 148
Desktop Notifications .......................................................................... 150
Outlook Integration Troubleshooting ..................................................... 150
    Enabling Add-ins in Microsoft Outlook 2003 ...................................... 153
    Enabling Add-ins in Microsoft Outlook 2007 ...................................... 153
Trouble Joining a Meeting ................................................................. 155
    Test Your GoToMeeting Connection .................................................... 155
    Common Issues When Joining Meetings on PCs ................................... 156
    Common Issues When Joining Meetings on Macs ............................... 159
    Join or Host a Meeting Without Having Java on Your Mac .................. 163
        Join a Meeting - Attendee ................................................................. 163
        Host a Meeting - Organizer .......................................................... 166
Troubleshooting Java Issues ............................................................. 170
    Connection Wizard ............................................................................. 171
        Using the Custom Wizard (Advanced Users Only) .......................... 172
Welcome

GoToMeeting is designed to make it easy for everyone to organize and participate in online meetings, thus eliminating the need to travel and allowing you to be more efficient and productive with your time.

GoToMeeting users can collaborate on documents, deliver presentations, perform product demonstrations and securely share confidential information from anywhere, at any time. GoToMeeting’s rapid download, quick meeting setup and intuitive user interface have meeting organizers and attendees up and running in a matter of seconds.

GoToMeeting with HDFaces features the innovative new Citrix Multistream HD technology, which enables all participants to view up to 6 high-resolution video conferencing streams in a high-definition session. Participants can also view video and the presenter’s shared desktop in the same screen for the most natural virtual meeting experience yet.

GoToMeeting incorporates industry-standard security features and end-to-end SSL encryption to ensure that login information and meeting data are secure. This high level of security allows GoToMeeting users to confidently present and collaborate on any data. Users can rest assured that information such as sales forecasts, financial data and M&A contracts will not be viewable to anyone except meeting participants.

GoToMeeting’s All You Can Meet® pricing model provides easy-to-understand billing that helps you effectively budget and manage online meeting costs with no unexpected overage charges or additional fees. Meet as often and as long as you want for one low flat fee.

To further increase your savings, GoToMeeting now offers an extended choice of integrated audio conferencing services for your online meetings at no additional cost. With GoToMeeting integrated audio, you can choose between phone conferencing and Voice over Internet Protocol (VoIP) or allow both options.
Using This Guide

Guide Structure

This guide is divided into several sections:

- **Getting Started** - provides information on system requirements, useful terms and a product feature summary.
- **Install GoToMeeting** - covers information on creating an organizer account, installing GoToMeeting, managing your GoToMeeting Preferences, and GoToMeeting integration.
- **Organize Meetings** - describes how GoToMeeting organizers can schedule, view, edit and cancel meetings.
- **GoToMeeting Integrated Audio** - explains phone conferencing, VoIP, hardware setup recommendations and audio best practices.
- **HDFaces video conferencing** - describes how to share up to 6 high-resolution video conferencing streams while viewing the presenter’s screen.
- **Start Meetings** - describes the multiple ways an organizer can begin a meeting.
- **Presenter Controls** - provides GoToMeeting presenters with explanations about features available during a meeting, such as attendee management, audio, chat and drawing tools.
- **Record Meetings** - explains how to record, play back and distribute meetings.
- **Attend Meetings** - explains how any GoToMeeting attendee can join a meeting and use attendee features.
- **The GoToMeeting Web Site** - provides GoToMeeting organizers instructions for accessing and using the GoToMeeting Organizer website.

Individual and Corporate Plan Users

This user guide addresses both individual GoToMeeting users and GoToMeeting Corporate users. While most features apply to both audiences, some content relates to just one audience. To help you identify when something is just for one specific audience, this guide will clearly note the audience for any user-specific content.

Feature Notes

- Individual GoToMeeting organizers may invite up to 15 meeting attendees, for a total of 16 people in each meeting.
- GoToMeeting Corporate organizers may invite up to 25 meeting attendees, for a total of 26 people in each meeting.

Mac Users

GoToMeeting users can host and attend meetings on both PCs and Mac® computers. Significant differences in how GoToMeeting works on the Mac platform are highlighted with this icon.

© 2011 Citrix Online, LLC. All rights reserved.
System Requirements

For PC users:

- Windows® 7, Vista, 2003 server or XP
- Internet Explorer® 7.0 or newer, Firefox® 3.0 or newer or Chrome™ 5.0 or newer (JavaScript™ enabled. Java™ 1.6 or higher highly recommended.)
- Internet connection with cable modem, DSL or better recommended
- Dual core 2.4GHz CPU or faster with at least 2 GB of RAM recommended

For Mac users:

- Mac OS® X 10.7 (Lion®), Mac OS® X 10.6 (Snow Leopard®) or Mac OS® X 10.5 (Leopard®)
- Safari™ 3.0 or newer, Firefox® 3.0 or newer or Chrome™ 5.0 or newer (JavaScript™ enabled. Java™ 1.6 or higher highly recommended.)
- Internet connection with cable modem, DSL or better recommended
- Intel processor with 1 GB of RAM or better recommended

For iPad®, iPhone® and iPod® touch attendees:

- iPad® 1 or newer, iPhone® 3GS or newer, iPod® touch (3rd generation) or newer
- iOS® 4.2 or newer
- Internet connection (WiFi recommended for VoIP)
- Free GoToMeeting App from the App Store

For Android attendees:

- Android 2.2 or higher
- 1 Ghz CPU or higher recommended
- WiFi or 3G connection (WiFi recommended)
- Free GoToMeeting App from the Android Market

Note: Attendees on devices that use CDMA and do not allow simultaneous data and voice sharing must be connected to the Internet from a WiFi network to dial in using the same device they use to join the meeting. Otherwise, they will be disconnected from GoToMeeting. Attendees on devices that use GSM can simultaneously share data and voice seamlessly.

- For the best audio experience, a headset recommended.

To use a microphone and speakers (VoIP):

- A fast broadband connection with 384 kbps or more recommended
- Microphone and speakers with a USB headset recommended

To record a meeting (PC-only):

- Windows Media® Player Version 9.0 or newer
- Minimum of 800 x 600 Super VGA, with 1024 x 768 or higher screen resolution recommended
- 1 GB of hard disk space

Recording a meeting is only available on a PC.
Integrations

- **Microsoft® Office® Integration**: Microsoft Office 2002 or later
- **Outlook Integration**: Microsoft Outlook® 2000 or later
- **Lotus Notes® Integration**: IBM® Lotus Notes Version 7.0 or later
- **Instant-Messaging Integration**: GoToMeeting integrates with the most widely used instant-messaging applications including Yahoo!® Messenger™, Windows Live™ Messenger, Skype™ Chat, Microsoft® Communicator and Google Talk™

**Note**: Only GoToMeeting organizers can use Instant-Messaging Integration options at this time.
Terms

- **Organizer** - An organizer has a GoToMeeting account that enables him or her to schedule and host meetings. The organizer can also grant and revoke attendee privileges, such as passing the presenter role, sharing keyboard and mouse, inviting attendees and dismissing others.

- **Attendee** - An attendee is any person who attends a meeting, including organizers and presenters. By default, attendees can view the presenter's screen. An attendee may remotely control the presenter's computer screen if given the privilege. An attendee may optionally chat with other attendees, use Drawing Tools or view the Attendee List.

- **Presenter** - A presenter is any attendee who is giving a presentation and shares his or her computer screen with all the attendees. The initial presenter is also the initial meeting organizer. The presenter also determines who gets to control the keyboard and mouse of the remotely viewed screen.

- **GoToMeeting Website** - The website located at www.gotomeeting.com is where organizers manage their accounts and host meetings and also where attendees join meetings.

- **GoToMeeting System Tray Icon** - The system tray icon is used by PC users to access organizer features of GoToMeeting and to provide status of GoToMeeting service. To access organizer features, right-click the system tray icon and select the desired feature.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>🔥</td>
<td>GoToMeeting is in Session – A meeting is in progress.</td>
</tr>
<tr>
<td>🔄</td>
<td>GoToMeeting is Starting/Stopping - The application is starting up or shutting down. When this icon is showing, the user will not have any menu options.</td>
</tr>
<tr>
<td>🛡️</td>
<td>GoToMeeting is Connecting - The application is attempting to establish a connection with the server. This icon is animated to look like it is “filling up”. While connecting, the user has a very limited set of menu options (Help, About, Exit).</td>
</tr>
<tr>
<td>💥</td>
<td>GoToMeeting is Ready – A connection has been made, and the application is ready to be used. The user has all menu options available.</td>
</tr>
<tr>
<td>🪄</td>
<td>GoToMeeting is Offline – A connection has been made, but there is some temporary network difficulty. The user will still have all menu options available.</td>
</tr>
<tr>
<td>🎯</td>
<td>GoToMeeting is Not Connected – A connection could not be established. The user has a very limited set of menu options (Help, About, Exit).</td>
</tr>
</tbody>
</table>

- **GoToMeeting Suite Icon** - Mac users can access organizer features by double-clicking on the GoToMeeting Suite icon on their desktop.

- **Account Password** - An account password is what organizers use to log in to the GoToMeeting website. It must contain at least eight characters and include both letters and numbers.

- **Meeting Password** - A meeting password is an optional value chosen by the meeting organizer that is used to help authenticate attendees. Requiring and specifying a meeting password provides enhanced privacy guarantees for the meeting by ensuring that only attendees who know the meeting password may join the meeting. The meeting password is never transmitted to Citrix Online in any form. The meeting password may be any alphanumeric string of one character or more the organizer would like such as: "7891," "Happy Birthday," "Citrix123," etc. Picking a meeting password that is difficult to guess helps to maximize security.

- **Viewer** - The Viewer is the window displayed on the attendees’ computers in which the presenter’s PC desktop or shared application appears. The Viewer window has its own title and menu bars.

- **Presenter’s PC Image** - The presenter’s PC Image is the picture of the presenter’s PC desktop or shared application that appears to attendees in the Viewer window.

- **Published Application** - An application that is pushed to a client PC by Citrix Presentation Server.
# Product Features

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Intuitive User Interface</td>
<td>Start and join meetings in seconds without training using easy-to-understand controls.</td>
</tr>
<tr>
<td>Specific Application Sharing*</td>
<td>PC-based presenters only. Display only one application, so the entire desktop does not have to be shown and interruptions will not occur by distracting pop-ups from instant messages or email.</td>
</tr>
<tr>
<td>Screen Clean*</td>
<td>PC-based presenters only. Instantly hide desktop icons, wallpaper background and toolbars, so attendees won’t be distracted by them.</td>
</tr>
<tr>
<td>GoToMeeting Integrated Audio</td>
<td>Offer choice of audio service between phone conferencing and Voice over Internet Protocol (VoIP) options for you and your attendees; you can allow both options to be used in the same meeting.</td>
</tr>
<tr>
<td>HDFaces Video Conferencing</td>
<td>You and your meeting participants can collaborate and by broadcasting up to 6 high-resolution video conferencing streams while sharing your screen.</td>
</tr>
<tr>
<td>Mac Support</td>
<td>Organize, present and attend meetings from a Mac.</td>
</tr>
<tr>
<td>Share Keyboard and Mouse Control</td>
<td>Securely collaborate on documents in real time.</td>
</tr>
<tr>
<td>Instantly Change Presenters</td>
<td>Enable any participant to present to the entire group.</td>
</tr>
<tr>
<td>Desktop Recording and Meeting Playback*</td>
<td>PC-based presenters only. Record and play back meeting sessions to review meetings or send copies to absent colleagues or customers.</td>
</tr>
<tr>
<td>Chat Window</td>
<td>Chat online with any participant in the meeting.</td>
</tr>
<tr>
<td>Drawing Tools - Pen, Highlighter, Arrow, Spotlight</td>
<td>Draw, highlight and point to items of interest right on the screen. Presenters can use the spotlight and erase all markings on the screen.</td>
</tr>
<tr>
<td>Multiple Monitor Support</td>
<td>Integrate GoToMeeting with multiple monitor systems, so users can use one for screen sharing and the other for different tasks, or share all of their screens.</td>
</tr>
<tr>
<td>Transparent Control Panel</td>
<td>Keep Control Panel open on the screen while screen sharing and chatting.</td>
</tr>
<tr>
<td>Integration*</td>
<td>Easily start or join GoToMeeting sessions through various email and instant-messaging applications.</td>
</tr>
<tr>
<td>Attendee Authority</td>
<td>Grant and revoke attendee privileges before or during a meeting session.</td>
</tr>
<tr>
<td>Reporting</td>
<td>Get detailed reports for trend analysis and ROI validation.</td>
</tr>
<tr>
<td>True 24-Bit Color</td>
<td>Share presentations, graphics, pictures and applications with all meeting attendees in true 24-bit color.</td>
</tr>
</tbody>
</table>

Features marked with an asterisk (*) are not currently available for Mac users.
Install GoToMeeting

Before you can schedule or start a meeting for the first time, you must create a GoToMeeting account and download the GoToMeeting software. It generally takes less than 2 minutes to set up a GoToMeeting account.

Create Your Organizer Account - Individual Organizers

Personal plan users need to sign up for service.

▶ To create your account

1. Go to www.gotomeeting.com and click the Try It Free button.
2. On the Create Your Account page, enter your information and click Continue.
3. Enter your password and click Continue.
4. If required, enter credit card and billing information and click Get Free Trial.
5. On the GoToMeeting Software page, click the Install Our Software button.
6. If prompted, click Yes, Grant (or Trust on a Mac) to accept the download.

Create Your Organizer Account - Corporate Plan Users

If you are a GoToMeeting Corporate user, you will be invited to join by your company's GoToMeeting Administrator. Before being able to schedule or start a meeting, you need to create your GoToMeeting account and download the GoToMeeting software.

▶ To create your Corporate Plan organizer account

1. Go to your email application and open the GoToMeeting invitation email you received from your administrator entitled GoToMeeting Account Confirmation.
2. In the email, click the activation link to create your organizer account.
3. On the Create Account page, enter your information and click Create Account.
4. On the Download GoToMeeting page, click the Download button.
5. If prompted, click Yes, Grant or Trust to accept the download.
Install GoToMeeting

Installing GoToMeeting is as simple as hosting a meeting from www.gotomeeting.com. Unlike most other applications, GoToMeeting does not install until you host your first meeting, which may be a practice meeting. You may install GoToMeeting on as many of your computers as you like, but keep in mind you can only host a meeting from one computer at a time.

Note: Installing new software like GoToMeeting typically requires administrative access to your PC or Mac. Most individual users have administrative access to their personal computers but this isn't always the case at work. If you encounter installation issues while installing GoToMeeting on a work PC or Mac then you may have limited access to certain admin functions and require assistance from your IT department.

To download and install or reinstall GoToMeeting

1. From any PC or Mac host a practice meeting from www.gotomeeting.com, by clicking on Host a Meeting, or click here to start the installation process.
2. Enter your email and GoToMeeting password and then click Log In.
3. Click Meet Now and host a practice meeting.

Congratulations - the GoToMeeting application is installed!

For PC users, the GoToMeeting icon appears at the bottom-right of your screen in the system tray and is ready for use.

For Mac users, the GoToMeeting Suite icon appears on your desktop. Once downloaded, GoToMeeting can be moved from your desktop to a location of your choice, including your dock.
Upgrade to GoToMeeting with HDFaces

GoToMeeting, GoToWebinar and GoToTraining organizers can now upgrade their individual seat and begin using GoToMeeting with HDFaces by logging in to www.gotomeeting.com or visiting the GoToMeeting with HDFaces upgrade page.

Note: If you are an organizer on a corporate plan and cannot self-upgrade, please contact your GoToMeeting administrator.

To upgrade your account, follow these 4 steps:


2. Log in to your existing GoToMeeting account, and click the Upgrade button.

3. Review the list of new features, and click the Upgrade Account button to upgrade your account to GoToMeeting with HDFaces.

Note: Once you click the Upgrade Account button, you cannot self-downgrade to your previous version of GoToMeeting.

Note: If you are a GoToMeeting Web Viewer Beta user and upgrade to GoToMeeting with HDFaces, you will lose web-viewer functionality. If you want to return to the Web Viewer Beta, you can opt in again via http://www.gotomeeting.com/webviewer/beta or call Global Customer Support.
4. Click the **Download** button to install the new version of GoToMeeting with HDFaces.

   **Note:** If you have GoToMeeting installed on multiple computers, the new version of GoToMeeting will be installed once a GoToMeeting session is hosted from those computers.

   **Congratulations - GoToMeeting has been upgraded!**
The GoToMeeting Application

To access GoToMeeting functions directly from your PC desktop, right-click the icon in your system tray and select the desired function.

- **Meet Now**: Enables you to immediately start impromptu meetings without needing to enter meeting information.
- **Schedule a Meeting**: Enables you to schedule meetings.
- **My Meetings**: Provides access to your scheduled meetings and lets you add, edit or delete scheduled meetings.
- **Join**: Enables you to join meetings already in progress.
- **Help**: Launches online help.
- **Preferences**: Provides access to user preferences.
- **About**: Provides GoToMeeting software version information.
- **Exit**: Closes the GoToMeeting application.

**Note**: If your account includes GoToWebinar, additional menu options will appear.

Mac users can access many GoToMeeting functions by double-clicking the GoToMeeting icon on their desktop or clicking the icon in their dock. Other functions, including Help and Preferences, can be accessed from the GoToMeeting menu bar.
Preferences for PC Users

The GoToMeeting Preferences feature allows you to set preferences for running GoToMeeting, choose which GoToMeeting integrations are displayed and test the GoToMeeting connection.

PC users can access GoToMeeting Preferences by right-clicking the icon in the system tray, or if in a meeting, from the File menu.

Note: Preference options outlined in this guide are specific to GoToMeeting. If your account includes GoToWebinar, additional preference options will appear. For more information on GoToWebinar preference options, please refer to the Getting Started section of the GoToWebinar help.

Start Up Preferences

The Start Up category lets you determine how you start GoToMeeting.

- **Automatically after I log in to Windows** - This option starts GoToMeeting automatically after you log in to your PC.
- **Manually** - This option sets GoToMeeting to start only when you launch the application from your Programs menu.
- **Remember me on this computer** - This checkbox enables automatic login to GoToMeeting.
- **Show me desktop notifications** - Desktop Notifications is a free GoToMeeting feature designed to deliver simple and effortless access to complimentary Citrix Online software upgrades, information, news and discounts individual users may be eligible for.
- **Remind me of upcoming meetings** - This checkbox becomes available if you select Remember me on this computer and provides reminders for your scheduled meetings.
- **Periodically synchronize reminders with My Meetings** - This option is applicable to Citrix Presentation Server users and is the recommended setting for optimal use. This checkbox becomes available if you select the Remind me of upcoming meetings checkbox and will synchronize meetings scheduled from a published Outlook® or Lotus Notes® with a local installation of GoToMeeting.
General Preferences

The General category lets you set your general GoToMeeting preferences.

- **File save settings** - Enables you to save the Chat Log to any drive or directory.
- **Security** - Set the inactivity timeout to automatically stop screen sharing if there is no keyboard input or mouse movement for the specified period of time.
- **Session Identity** - Remember your name and email as displayed in the attendee list.

Meetings Preferences

The Meetings category lets you determine which GoToMeeting options are available to attendees during a meeting. You can also select which messages are viewable during a meeting.

- Enable or disable the ability for attendees to chat and view the Attendee List.
- Create a Chat Welcome Message that is sent to each attendee upon joining the meeting.
- Enable or disable various system messages that appear to you when specific meeting actions occur.
- Select the desired color for your GoToMeeting Viewer and Control Panel.

**Note:** If you disable the Chat Bubbles option, a new message icon will still appear on the Grab Tab to notify you of new chat messages as they are received.
Recording Preferences

The Recording category lets you set your audio and video recording preferences. See Record a Meeting for more information.

- **Audio** - Allows you to enable or disable recording the audio portion of your meeting. To record, choose which audio service you have scheduled to use for your meeting (see the following table).
- **Video** - Allows you to select the meeting recording output format and destination for saving the file.

**Note:** Be sure to check your audio device settings under Audio in the left menu.
**Note:** Mac users can only view meetings recorded in the Windows Media Player format.

- **Save in** - Select the folder in which you want to save your recording.

<table>
<thead>
<tr>
<th>Using GoToMeeting Integrated Audio</th>
<th>Using Your Own Audio Service</th>
</tr>
</thead>
<tbody>
<tr>
<td>Records all unmuted speakers in the meeting.</td>
<td>To record all unmuted speakers, you will need a phone patch connected to both your phone and the mic in port of your PC.</td>
</tr>
<tr>
<td></td>
<td>To record just your voice, you will need a microphone connected to your PC.</td>
</tr>
<tr>
<td></td>
<td>If you want to use VoIP with your own audio service, please contact your Account Manager (GoToMeeting Corporate plans) or Global Customer Support (GoToMeeting plans).</td>
</tr>
</tbody>
</table>

Your PC must have a sound card installed in order to record audio. For example, if you can hear music through your PC, you have a sound card.

Mac users are not able to record a meeting. If you want your meeting recorded, promote a PC attendee to organizer in-session. A PC-based organizer will have the recording feature.
Integration Preferences

The Integrations category lets you determine where to display GoToMeeting integrations. Options include:

- **Use GoToMeeting with** - Select your GoToMeeting email and calendar integration. By selecting My default email application you can integrate with MAPI-compliant email/calendar programs other than Microsoft Outlook and Lotus Notes. Depending on your email application’s capabilities, integration with MAPI-enabled programs allows for features such as automatically adding meetings to a calendar and automatic creation of email messages with meeting information.

- **Show button in messenger applications** - Display the GoToMeeting Quick Launch button in your selected instant-messaging applications.

**Note:** Changes will only be displayed after restarting Outlook, Lotus Notes and/or the instant-messaging application.

**Note:** Citrix Presentation Server users may have their Integrations settings automatically configured by their Presentation Server Administrators so that GoToMeeting integrates with published email and calendaring software. In order to integrate with published email and calendaring software, the Integrations setting should have no check mark in the Use GoToMeeting with box and all meetings should be scheduled from the published Outlook/Lotus Notes toolbar. This is also the recommended setting if your are prompted to disable local email client integration.

Connection Preferences

The Connection category allows you to test the status of your GoToMeeting connection.

**Note:** To ensure a valid connection test, we advise that you refrain from testing your connection unless a GoToMeeting Global Customer Care representative directs you to perform the connection test.
Audio Preferences

The Audio category lets you set up and test your microphone and speakers for recording and for your meetings utilizing VoIP. If changes to your audio settings are made during a meeting, your microphone is temporarily muted so you can privately manage your settings. See GoToMeeting Integrated Audio for more information.

- **Microphone Setup** - Select a microphone from the drop-down menu. To test, speak into your microphone; if connected correctly, the sound bar will move when you speak.
- **Speakers Setup** - Select your speakers from the drop-down menu. To test, click Play Sound; if connected correctly, the sound bar will move and you will hear a short soundtrack.
- **Advanced** - GoToMeeting automatically adjusts system mixer settings. We recommend you keep this checked. If you uncheck this selection, you must manually configure your audio settings through Windows Sounds and Audio Devices.
- **Use automatic volume and noise processing** - This option usually improves audio quality when people are talking. Unchecking this box may improve quality of music or other audio sources.

Webcam Preferences

The Webcam category lets you set up and test your webcam for HDFaces Video Conferencing. Options include:

- **Your camera** - Shows the make and model of your detected webcam.
- **Select a display format** - Adjusts the aspect ratios of webcam feeds. (4:3 is the normal display and 16:9 is the widescreen display.
- **Advanced** - Modifies your hardware settings from within GoToMeeting. Customizable options depend on your webcam manufacturer.
Preferences for Mac Users

GoToMeeting Preferences allow you to set preferences for running GoToMeeting, choose which GoToMeeting integrations are displayed and test the GoToMeeting connection.

Mac users may access GoToMeeting preferences by double-clicking the GoToMeeting Suite icon on their desktop and selecting Preferences from the GoToMeeting menu in the menu bar.

Note: Preference options outlined in this guide are specific to GoToMeeting. If your account includes GoToWebinar, additional preference options will appear. For more information on GoToWebinar preference options, please refer to the Getting Started section of the GoToWebinar help file.

Start Up Preferences

The Start Up tab lets you determine whether GoToMeeting is available immediately after startup.

- Remember me on this computer - This checkbox enables automatic login to GoToMeeting.

General Preferences

The General tab lets you set your general GoToMeeting preferences.

- Session Identity - Remember your name and email as displayed in the Attendee List.

Meeting Preferences

The Meetings tab lets you determine which GoToMeeting options are available to attendees during a meeting. You can also select which messages are viewable during a meeting. Options include:

- Enable or disable the ability for attendees to chat and view the Attendee List.
- Create a Chat Welcome Message that is sent to each attendee upon joining the meeting.

Integrations Preferences

The Integrations tab lets you determine where to display GoToMeeting integrations.

By selecting My default email application, you can integrate with MAPI-compliant email/calendar programs other than Microsoft Outlook and Lotus Notes. Depending on your email application's capabilities, integration with MAPI-enabled programs allows for features such as automatically adding meetings to a calendar and automatic creation of email messages with meeting information.

Connection Preferences

The Connection tab allows you to test the status of your GoToMeeting connection.

Note: To ensure a valid connection test, we advise that you refrain from testing your connection unless a GoToMeeting Global Customer Care representative directs you to perform the connection test.
**GoToMeeting Outlook Toolbar**

The GoToMeeting Outlook toolbar provides PC-based users quick and easy access to GoToMeeting functions right from Microsoft Outlook. It includes the **Meet Now** and **Schedule Meeting** buttons, in addition to links to **Host a Meeting** and **Join a Meeting** and access to the **My Meetings**, **Help** and **About** pages.

The GoToMeeting Outlook bar can be added or removed from the **Preferences** menu.

Integration with Microsoft Outlook is currently unavailable on the Mac.

**To add the Outlook Toolbar**

1. Right-click the icon in the system tray and select **Preferences**.
2. On the **Integrations** tab select Outlook and any other applications you would like integrated with GoToMeeting.
3. Click **OK**.

Outlook may need to be shut down and restarted for the GoToMeeting Outlook bar to appear.
GoToMeeting Lotus Notes Menu Options

The GoToMeeting Lotus Notes menu options provide quick and easy access to GoToMeeting functions right from the IBM Lotus Notes interface. It includes the Meet Now and Schedule Meeting buttons, in addition to access to your My Meetings dialog box.

Note: Lotus Notes integration requires IBM Lotus Notes 7.0 or newer. Lotus Notes may need to be shut down and restarted for the GoToMeeting menu options to appear. The GoToMeeting Lotus Notes menu options can be added or removed from the GoToMeeting Preferences menu. Organizers using Citrix Presentation Server should contact their Presentation Server Administrator to display or remove the GoToMeeting Lotus Notes menu options in their published IBM Lotus Notes.
**GoToMeeting Messenger Button**

The GoToMeeting Messenger button provides convenient access to starting an impromptu meeting right from the Messenger application.

Note: Please see the Software Requirements section to check what instant-messaging products and versions are supported. Instant-messaging applications may need to be shut down and restarted for the GoToMeeting Messenger button to appear. The GoToMeeting Messenger button can be added or removed from the Preferences Integrations category.

---

**Add a GoToMeeting Corporate "Meet Now" Button to Your Website**

As a GoToMeeting Corporate account administrator, you can embed a GoToMeeting "Meet Now" button to your website so that attendees can easily join a scheduled or impromptu meeting. To add any of the "Meet Now" buttons to your website, copy one of the HTML codes below and paste it into the source code of the page where you’d like to embed the button.

▲ To schedule a meeting using the "Meet Now" button

1. **Schedule a meeting** set for a future date or start an **impromptu meeting**.

2. Instruct your attendees to visit your website and click the "Meet Now" button to join the meeting. They can also join the meeting by clicking the Join URL in the GoToMeeting invitation email.

3. If your attendees click on of the "Meet Now" buttons without the Meeting ID field, they are directed to [www.gotomeeting.com/join](http://www.gotomeeting.com/join) where they are prompted to enter the Meeting ID (the 9-digit number provided by the meeting organizer). Once they enter the Meeting ID and click **Join a Meeting**, they will be launched into session!

If your attendees are provided with the option to enter the Meeting ID above the "Meet Now" button on your website, once they enter the Meeting ID, they will be seamlessly launched into session!

---

```
*<a href="https://www.gotomeeting.com/join"><img src="http://img.gotomeeting.com/g2mimages/ad/messages/images/160_80_a.gif" width="160" height="80" border="0"></a>*
```
### Small White Button

![Small White Button](http://img.gotomeeting.com/g2mimages/ad/messages/images/120_60_a.gif)

### Blue Button with Meeting ID Field

![Blue Button with Meeting ID Field](http://img.gotomeeting.com/g2mimages/ad/meetNowB.js)

### White Button with Meeting ID Field

![White Button with Meeting ID Field](http://img.gotomeeting.com/g2mimages/ad/meetNowW.js)
Set Up GoToMeeting for Use with Citrix Presentation Server

Preferences

Depending on your Presentation Server environment, your Presentation Server administrator can choose to configure your GoToMeeting settings for you without notifying you; configure your settings and notify you of those settings; or allow you to configure them yourself. If your administrator has chosen your configurations for you, you won’t need to do anything; if your administrator has configured your settings and opted to notify you, you will see a notification dialog when you start your first meeting from your published environment.

If your Citrix Presentation Server administrator has not already configured your GoToMeeting preferences, the recommended settings can be configured under the StartUp tab and the Integrations tab in the Preferences dialog.

Recommended settings for the Start Up category:

- Enable Remind me of upcoming meetings - This checkbox becomes available if you select Automatically log in to GoToMeeting and will provide you with reminders for your scheduled meetings.
- Enable Periodically synchronize reminders with My Meetings - This Preferences option is applicable to users of Citrix Presentation Server and is the recommended setting for optimal use. This checkbox becomes available if you select the Remind me of upcoming meetings checkbox and will synchronize meetings scheduled from a published Outlook® or Lotus Notes® with a local installation of GoToMeeting.

Recommended settings for the Integrations tab:

1. Select your desired integration from the list of GoToMeeting integrations
2. Click the Advanced button and confirm that the application listed in the Application Name field is the same as your selection from the GoToMeeting Integrations list.
To configure GoToMeeting preferences

1. Right-click the GoToMeeting system tray icon and select *Preferences*,
   
   Or
   
   When in a meeting, select *Preferences* from the Tools menu in the Control Panel.

2. Select the appropriate category for the set of preferences you want to customize.
3. Select your preferences.
4. Click *OK*.

Displaying the GoToMeeting Toolbar in Published Outlook

Organizers using Outlook published by Citrix Presentation Server may need to activate the Outlook toolbar manually in order for it to display the first time.

To activate the Outlook toolbar if it does not automatically display

1. Open Outlook.
2. Select *Customize* from the Tools menu.
3. Click to check the box next to GoToMeeting.

4. The Outlook toolbar will appear in your published Outlook on the Citrix Presentation Server.

   ![Customize Toolbar](image)

   **Note:** You may need to restart Outlook for the toolbar to appear.

Removing the Outlook Toolbar in Published Outlook

▶ **To remove the Outlook toolbar**

1. Open Outlook.
2. Select **Customize** from the Tools menu.
3. Deselect GoToMeeting from the list of toolbars.

For more information about using GoToMeeting with Presentation Server, refer to [GoToMeeting for Citrix Presentation Server FAQs](#).
Organize Meetings

Organizer Role Overview

With a GoToMeeting account, you as an organizer can schedule and host meetings, grant and revoke attendee privileges like passing the presenter role and inviting/dismissing attendees.

- You need to first create your account and download the GoToMeeting software on your computers before you can schedule or conduct meetings.
- You must be present at the start of any meeting as the meeting host.
- You are responsible for creating scheduled meetings or starting impromptu meetings.
- You invite attendees and may do so via phone, email or instant message.
- GoToMeeting meetings can be started from the icon in the PC system tray, the Mac GoToMeeting Suite icon, the GoToMeeting website, the GoToMeeting Outlook bar or the GoToMeeting Messenger button.
- Once a meeting starts, you become the meeting presenter. During the meeting, you may pass the role of presenter to other attendees or promote an attendee to co-organizer.
Schedule a Meeting

As a GoToMeeting organizer you can quickly schedule meetings in advance or start an impromptu meeting directly from your desktop. Once a meeting is scheduled, you can host as many meetings as you like with the existing meeting information no matter when it is scheduled. If you wish to save that meeting information for future meetings then select the Recurring meeting option.

Keep in mind that a scheduled meeting automatically expires one hour following the scheduled end time if the meeting does not occur, or if the meeting concludes within the hour. For more information see Expired Meetings.

Cancel a Scheduled Meeting

Schedule a Meeting from Your Desktop

To schedule a meeting from your desktop

1. Right-click the icon in the system tray on a PC or double-click the GoToMeeting Suite icon on a Mac and select Schedule a Meeting.

2. If prompted, enter your email and password and click Log In.

3. On the Schedule a Meeting window, enter:
   - **Subject** - Enter the title of your meeting.
   - **When will this meeting take place?** - Select the date and start time.
   - **Recurring meeting** - Check this box to reuse the same meeting information for future meetings.
   - **Audio** - Select the GoToMeeting integrated audio or use your own.
   - **Provide VoIP only (requires microphone and speakers)** - All attendees join the audio portion via the Internet with built-in VoIP (Voice over Internet Protocol).
   - **Provide a conference call number only** - All attendees join the audio portion through the telephone.
   - **Provide both** - Allows all attendees to join the audio portion through the telephone or VoIP. Attendees joining through VoIP must have speakers to hear the meeting and a microphone if you would like them to speak. Attendees can switch between these audio options during a meeting.
   - **Meeting password** - If you wish to protect your meeting with a password, you will be prompted for it when you start your meeting and/or invite additional attendees. Your attendees will also need to know this password to join.

**Note:** If you are using the GoToMeeting Integrated Audio, you can provide toll numbers for multiple countries. Please see Schedule an International Meeting for more information.

© 2011 Citrix Online, LLC. All rights reserved.
4. Click the **Schedule** button when complete.

You will receive notification that your meeting has been scheduled. If you have chosen to integrate with Lotus Notes or Microsoft Outlook, a meeting reminder will be generated and give you the option of inviting attendees via a Calendar appointment. See the *Integrated Preferences* section of **PC Preferences**.

**Note:** In order to find the conference call number without Outlook or Lotus Notes integration, begin the meeting: the number is displayed in the Audio tab.

**View Scheduled Meetings**

**To view your scheduled meeting**

- Right-click the 📦 icon in the system tray on a PC or double-click the GoToMeeting Suite icon on a Mac and select **My Meetings**.

  -Or-

- You can also view your scheduled meeting online from the **My Meetings** screen until one hour following the scheduled meeting time, when the meeting automatically expires.
Schedule Recurring Meetings

With the recurring meeting feature your meeting ID, phone number, access code and any other settings are preserved indefinitely for your future recurring meetings. This feature can be a time saver if you have routine meetings or want to post the information on a website. Please see Schedule a Meeting for more information.

There are a few important considerations to keep in mind when creating recurring meetings:

- The recurring meeting will only appear once in the My Meetings window and the Organizer website and will be labeled "Recurring." You will need to use your own local calendar applications to schedule and track recurring meetings.
- The Meeting URL/ID and conference number stays available indefinitely.
- Scheduled meetings that aren't marked as Recurring will expire one hour following the scheduled meeting end time if the meeting does not occur, or if the meeting concludes within the hour.
Schedule International Meetings

As a GoToMeeting organizer you can offer your international attendees conference numbers specific to the country they are calling from. For example, if your attendees join from three different countries then you can provide three different international numbers that all access the same meeting. By doing this you and your attendees can avoid international rates and the trouble of looking up and dialing International Country Codes. To manage your default country preferences please see Audio Conference Options.

The GoToMeeting Toll audio conference service includes the following international coverage.

<table>
<thead>
<tr>
<th>International Toll Conference Numbers</th>
</tr>
</thead>
<tbody>
<tr>
<td>Australia</td>
</tr>
<tr>
<td>Austria</td>
</tr>
<tr>
<td>Belgium</td>
</tr>
<tr>
<td>Canada</td>
</tr>
<tr>
<td>Denmark</td>
</tr>
<tr>
<td>Finland</td>
</tr>
</tbody>
</table>

The GoToMeeting Integrated Toll-Free audio conferencing service includes the following international coverage. Note this option is a separately purchased service. Please see Integrated Toll-Free Audio for more information.

<table>
<thead>
<tr>
<th>International Toll-Free Conference Numbers</th>
</tr>
</thead>
<tbody>
<tr>
<td>Australia</td>
</tr>
<tr>
<td>Austria</td>
</tr>
<tr>
<td>Belarus</td>
</tr>
<tr>
<td>Belgium</td>
</tr>
<tr>
<td>Brazil</td>
</tr>
<tr>
<td>Canada</td>
</tr>
<tr>
<td>China</td>
</tr>
<tr>
<td>Czech Republic</td>
</tr>
<tr>
<td>Denmark</td>
</tr>
<tr>
<td>Finland</td>
</tr>
<tr>
<td>France</td>
</tr>
</tbody>
</table>
To schedule a meeting with international conference numbers

1. From the Schedule a Meeting window select GoToMeeting conference call service and then the Edit countries link.
2. From the Edit Countries window select as many countries as necessary and click Done.
3. Click Schedule to confirm the new meeting.
View Scheduled Meetings

Organizers can view all scheduled meetings via the GoToMeeting application.

Cancel a Scheduled Meeting

To view scheduled meetings via the GoToMeeting application

1. Right-click the icon in the PC system tray or double-click the GoToMeeting Suite icon on a Mac and select My Meetings.
2. Enter your Email and Password in the Login window, and click Log In.

The My Meetings window appears listing all scheduled meetings.

Note: Scheduled meetings may also be viewed from the www.gotomeeting.com website after logging in to your account.
Invite Attendees to a Scheduled Meeting

An organizer can invite attendees to a scheduled meeting at any time prior to the start of the meeting.

**Note:** For information on how to invite attendees to a meeting already in progress, please see the Invite Attendees During a Meeting section.

To invite attendees to a scheduled meeting

1. Right-click the 🎖️ icon in the PC system tray or double-click the GoToMeeting Suite icon on a Mac and select **My Meetings**.
2. Enter your Email and Password in the **Login** window, and click **Log In**.
3. On the **My Meetings** window, select the meeting you want to invite attendees to by clicking the name of the meeting in the Subject column, and click the **Invite** button.
   - If you have an integrated email application an email will automatically be generated with the meeting information included in the body text: Simply send the email to attendees.
   - If you do not have an integrated email application, the **Meeting Scheduled window** will appear: Simply click the **Show invitation text** link to display the invitation information and on the **Invitation Text - GoToMeeting** dialog box click the **Copy to Clipboard** button and paste the invitation information into your email program or convey the information to attendees via any desired method.
Edit a Scheduled Meeting

Editing a scheduled meeting can be done at any time prior to the start of the meeting directly from your desktop. If you change the date and time you must remember to notify your attendees of that change. The easiest way to notify your attendees is to send out a new invitation.

To edit a scheduled meeting

1. Right-click the icon in the PC system tray or double-click the GoToMeeting Suite icon on a Mac and select **My Meetings**.
2. If prompted, enter your Email and Password in the **Login** window, and click **Log In**.
3. Select the meeting you want to modify and then click the **Edit** button.
4. Make any changes and click **Save**.

5. Be sure to contact any previously invited attendees to notify them of the change!

If you re-schedule a meeting:

If you reschedule a meeting, you must update the information in both your Outlook calendar and the GoToMeeting software. Updating your Outlook calendar should notify affected participants of the change in time, but does not change the time in GoToMeeting. After updating your Outlook calendar appointment, you also need to update your meeting in the GoToMeeting software in order to reschedule. If you change the scheduled start time of your meeting in your Outlook calendar without changing the meeting time in GoToMeeting, your meeting may expire if you do not start it on time.
**Expired Meetings**

After you schedule a meeting, you can start or modify it for up to one hour after the scheduled end time. After this time, a meeting expires and cannot be started, modified or otherwise accessed. If you need to reschedule a meeting, you must do so from within the GoToMeeting software and not with Outlook or another email client.

*Note:* Although GoToMeeting creates calendar appointments in Microsoft Outlook, it does not synchronize your scheduled meetings with your Outlook calendar. See [Edit a Scheduled Meeting](#).

To change the date or time of a scheduled meeting

1. Right-click the ☯ icon in your system tray and select *My Meetings*.
2. Select the meeting time you want to change and click *Edit*.
3. Enter the new meeting start time and click *Save*.

![My Meetings - GoToMeeting](image)
Cancel a Scheduled Meeting

As a GoToMeeting organizer you can easily delete a scheduled meeting at any time prior to the start of the meeting directly from your desktop.

Note: Canceling a scheduled meeting will not be automatically updated in Microsoft Outlook or other calendar applications; neither will meeting attendees receive notice of the cancellation from GoToMeeting. Please be sure to contact meeting attendees directly to notify them of the cancellation.

To cancel a scheduled meeting

1. Right-click the icon in the PC system tray or double-click the GoToMeeting Suite icon on a Mac and select My Meetings.
2. If prompted, enter your Email and Password and click Log In.
3. Select the meeting you want to cancel and click Delete.
4. Click Ok to confirm deletion of meeting.
5. Be sure to notify any previously invited attendees about the cancellation!
Set GoToMeeting Time Zone

When you first create your account, GoToMeeting sets the default meeting time to Pacific Time. To have your meeting times display in your local time zone, you will need to update your default time zone setting.

To set GoToMeeting time zone

1. Open an Internet browser and go to www.gotomeeting.com.
2. Click Log In on the top-right of the screen.
3. In the Returning Users section, enter your email address and password and click the Log In button.
4. In the left navigation bar, click My Account.
   The My Account Details page loads displaying organizer account information.
5. At the top of your My Account Details page, enter your current Password.
6. In the Time Zone drop-down selection box, select your time zone and click Save Changes.
Mobile Devices

GoToMeeting App for iPad, iPhone & iPod Touch FAQs

What is the GoToMeeting app for iPad, iPhone & iPod Touch?

GoToMeeting now offers attendees the flexibility to attend meetings and webinars directly from an Apple® iPad, iPhone and iPod Touch. The free GoToMeeting app enables iPad, iPhone and iPod Touch attendees to view online meeting content shared by a GoToMeeting organizer or presenter from a Mac® or PC. Attendees are not required to have a GoToMeeting account to join a meeting or webinar.

To leave feedback about your GoToMeeting app experience, fill out the GoToMeeting Feedback form. After each session, you can also tap the How was your GoToMeeting? button to leave your feedback.

What can I do with GoToMeeting on an iPad, iPhone or iPod Touch?

- Attend online meetings or webinars free of charge.
- Join sessions in seconds by tapping the Join link in your invitation email.
- View the presenter's screen.
- Connect to audio through your iPad, iPhone or iPod Touch's Internet connection or dial in by phone.
- Chat with everyone in the meeting, with only organizers or with individual attendees. (Chat isn't supported for GoToWebinar at this time.)
- Pinch with 2-fingers or double-tap to zoom.
- Switch between portrait and landscape mode.
- See who's talking and who's attending.

How much does the GoToMeeting app cost?

There is no cost for the GoToMeeting app. You can easily download the app from the App Store.

What are the mandatory system requirements to attend sessions from my iPad, iPhone or iPod Touch?

- Free GoToMeeting 4.8 app from the App Store.
- Organizer running the session must be using GoToMeeting 4.8 or later.
- iOS 4.2 or later.
- iPad 1 or newer, iPhone 3G or newer or iPod Touch 3rd Generation or newer.

Note: WiFi connection is highly recommended. If you are having trouble joining a session, please have the organizer contact GoToMeeting's Customer Support to make sure that they are using GoToMeeting 4.8 or later.

Can I join a GoToMeeting with HDFaces session from an iPad, iPhone or iPod Touch?

Yes. You can join HDFaces meetings as an attendee, but you'll be unable to view or share webcams and show your screen (if you're given presenter controls) at this time.

Are there any additional fees for using the GoToMeeting app?

The app is free, and there's no charge for attending meetings or webinars. However, you are responsible for any long-distance charges associated with dialing in to sessions by phone. There are no long-distance charges for using audio over your iPad, iPhone or iPod Touch's built-in mic & speakers (VoIP), but you'll be responsible for any data charges that may be incurred.

How do I join a session from an iPad, iPhone or iPod Touch?
If you know the 9-digit Meeting or Webinar ID, you can join the session by simply opening the GoToMeeting app and entering your name and the Meeting or Webinar ID (webinar attendees must also enter their email). If you already have the GoToMeeting app installed, you can also join a session by tapping the Join link in your GoToMeeting or GoToWebinar invitation email, which will automatically launch you into session.

**Where can I download the GoToMeeting app?**

You can download the free GoToMeeting app from the App Store.

**Can I host a meeting or webinar from my iPad, iPhone or iPod Touch? Can I show my screen if I'm given presenter controls?**

You can only join sessions as an attendee and cannot show your screen from your iPad, iPhone or iPod Touch at this time.

**How does attending a meeting or webinar on an iPad, iPhone or iPod Touch compare with the experience on a PC or Mac?**

Just as on a PC or Mac, you can view the presenter's screen, see who's attending and who's talking. However, some features are not yet available on the iPad, iPhone and iPod Touch, including drawing tools, presenter controls, keyboard and mouse controls and starting or scheduling sessions.

**How can I change the view or zoom into the presenter's screen?**

You can view the presenter's screen in both portrait and landscape mode. You can also double-tap anywhere on the GoToMeeting Viewer to change the display to Fill Screen mode. Double-tap a second time to zoom in to 100% mode. Double-tap a third time to return to the default view – Entire Screen mode. You can also pinch or expand with 2 fingers, and pan to different parts of the presenter's screen by dragging 1 finger across the GoToMeeting Viewer.

**Can I connect to audio from the GoToMeeting app?**

If the organizer provides both mic and speakers (VoIP) and conference call numbers, you will automatically connect to mic and speakers once you join. The audio quality on your iPhone depends on the quality and bandwidth available on the WiFi or 3G network that you're connected to. For best results, you should make sure you have nothing else running that might use up bandwidth. WiFi connection is highly recommended.

If the organizer only provides a conference call number, or if you prefer to dial in by phone, iPad attendees can tap the Settings button at the top right of the screen, tap Audio Settings and then Telephone to access the conference call information.

iPhone attendees can go to the Meeting Information screen and tap a U.S. phone number to automatically connect to the audio conference. With a single tap, the conference call number, access code and Audio PIN are automatically dialed.
How do I dial in to the audio conference by phone?

If the organizer provides a U.S. phone number, you can go to the Meeting Information screen in-session and tap the telephone number to automatically connect to the audio conference from your iPhone.

International telephone numbers do not have the single tap auto-dialing capability at this time. You can still use the Phone app on your iPhone to enter international telephone numbers manually and dial in to the audio conference.

Why can't I switch from phone to mic & speakers (VoIP)?

Once you dial in to the audio conference, mic and speakers (VoIP) is disabled for the remainder of the session. If they want to switch back to VoIP, you will need to leave the session and rejoin.

Why can't I connect to GoToMeeting and dial in on my iPhone?

If you have an iPhone 4 on the Verizon network (or any network that does not allow simultaneous voice and data over CDMA), you won't be able to connect to GoToMeeting and dial in on your iPhone at the same time. To connect to audio, you should use your iPhone's built-in mic and speakers (VoIP) or dial in with a different device.

If the organizer only provides a conference call number as the audio option and you try to dial in to the audio conference from a CDMA network without having a WiFi connection, you'll see a dialog notifying you that your device does not support simultaneous voice and data sharing. Once you tap the Dial button on the Join the Audio Conference dialog, you'll lose access to screen sharing.
What audio options does the GoToMeeting app support?

- iPad, iPhone or iPod Touch's built-in mic and speakers (VoIP).
- iPad, iPhone or iPod Touch's built-in mic along with external headphones connected via the 3.5-mm stereo headphone jack.
- Headset connected via the 3.5-mm stereo headphone jack.
- Bluetooth Hands Free devices.

For optimal audio quality, we recommend using a headset.

What version of GoToMeeting is required to host an iPad, iPhone or iPod Touch attendee?

An iPad, iPhone and iPod Touch attendee can only attend meetings or webinars that are hosted on GoToMeeting 4.8 or later. On a PC, the organizer can check their version and build number while in session by clicking the Help menu and selecting About GoToMeeting or About GoToWebinar. The organizer on a PC can also right-click the daisy icon (≡) in the system tray and select About. On a Mac, the organizer can click GoToMeeting in the toolbar and select About GoToMeeting.

Can I attend meetings that are password protected?

Yes, you can join password-protected meetings as long as you have the password, which is included in your GoToMeeting invitation email. All meetings are fully secured with end-to-end 128-bit AES encryption.

Will I have access to all of the session's conference call numbers?

Any conference call numbers provided by the organizer are available to an iPad attendee. iPhone attendees who prefer to dial in by phone can access the conference call number(s) (if provided by the organizer) in the GoToMeeting or GoToWebinar invitation email or Meeting Information screen.

Is the GoToMeeting app available on any other mobile device?

The GoToMeeting app is also available on Android smartphones and tablets.

Can I attend a GoToWebinar session from an iPad, iPhone or iPod Touch?

Yes! Simply use the GoToMeeting app to attendee webinars from your iPad, iPhone or iPod touch.

Can I attend a GoToTraining session from an iPad, iPhone or iPod Touch?

You can only join GoToMeeting and GoToWebinar sessions as an attendee at this time.
GoToMeeting App for Android FAQs

General Information

Can I use the GoToMeeting app for Android on my Android device?

Yes. If you're running Android 2.2 or higher, you can install the GoToMeeting app from the Android Market on your smartphone or tablet. We recommend using devices with a 1Ghz processor or higher for optimal performance.

How can I download the GoToMeeting app?

You can download the GoToMeeting app from the Android Market by signing in to your Google account linked with your Android device and search for the GoToMeeting app to install it. If you don't see an Install button, you may not be running Android 2.2 or higher - the minimum system requirement needed to install the GoToMeeting app.

If you have a Droid 3, the GoToMeeting app is pre-loaded on your device; however, you must first upgrade to the latest version of GoToMeeting before using it. To upgrade, find the GoToMeeting app and select the daisy icon to open it. Select the Upgrade button to install the most recent version of the app.

Why can I see the GoToMeeting app in the Android Market but can’t download it?

Your device may not be running Android 2.2 or higher (the minimum system requirement needed to install the GoToMeeting app). If your device is running 528 MHz CPU, you may not see the Install button to download the GoToMeeting app.

Can I host meetings from the GoToMeeting app?

Unfortunately, the GoToMeeting app for Android is only designed to support attendees who want to join meetings. Attendees who join meetings from their Android device will not be able to share their screen if given presenter controls. Attendees do not have to have a GoToMeeting account to use the GoToMeeting app.

Can I join or host a GoToWebinar, GoToTraining or GoToMeeting Global session from the GoToMeeting app?

No. The GoToMeeting app is only designed for attendees to join meetings.

Do I need a GoToMeeting account to join a meeting from my Android device?

No. As long as you're running Android 2.2 or higher, you can install the GoToMeeting app from the Android Market free of charge and join meetings from your device.

Can I use other apps on my Android device while I'm attending a meeting?

Yes. During a meeting, you can put the GoToMeeting app into background mode by pressing the Home button on your device to simultaneously use other apps without disconnecting from the meeting.

To re-open the GoToMeeting app, you can do any of the following:

- Select the GoToMeeting daisy icon from the Android app menu.
- Open the Notifications tab and select GoToMeeting.
- Hold down the Home button on your device until the Recent Apps screen appears. Select the GoToMeeting daisy icon.

© 2011 Citrix Online, LLC. All rights reserved.
Can I use a Bluetooth headset to connect to audio?

If your headset supports A2DP, you should be able to connect to GoToMeeting's audio. To see if your Bluetooth headset supports A2DP, try streaming or playing music - if you can hear music from your Bluetooth device, you most likely have a headset that supports A2DP.

Troubleshooting FAQs

Why can't I connect to a meeting from the GoToMeeting app for Android?

The meeting organizer must be using GoToMeeting v4.8 or higher for attendees to join meetings from Android devices. If the organizer is using an older version of GoToMeeting, you won't be able to use the GoToMeeting app; instead, you must join the meeting from a PC or Mac.

Why do I see an "Unable to Join the Meeting" error telling me that the Meeting ID is invalid?

If you manually entered the Meeting ID, double check to see that you typed it correctly.

I prefer to dial in to audio by phone. Where can I find the Audio PIN?

The Audio PIN is not created until the organizer starts the meeting. You can access the Audio PIN once the organizer arrives and you get into the meeting by selecting Settings from the View tab and selecting Meeting Information.

Why isn't the Audio PIN available in the Meeting Information?

If you joined the meeting before the organizer arrives, you won't be able to access the Audio PIN until after the organizer starts the meeting. Once the organizer starts the meeting, the Audio PIN will become available on the Meeting Information screen.

Why am I disconnected from GoToMeeting when I try dialing in from my device?

If you're using a device that doesn't allow simultaneous data and voice sharing (CDMA), you must connect to the Internet from a WiFi network to dial in using the same device you use to join the meeting; otherwise, you'll be disconnected from GoToMeeting. If you aren't connected to the Internet through WiFi, you must use your device's mic and speakers (VoIP) or dial in with a different device to connect to audio.

Why can't I access the Meeting Information in my Settings before the meeting starts?

You have to wait until you enter the meeting before you can access the Meeting Information. Once the organizer starts the meeting, you can access the Meeting Information by selecting the Settings button on the View tab.
GoToMeeting Integrated Audio

GoToMeeting includes an integrated audio solution at no extra cost to you. Choose between phone and Voice over Internet Protocol (VoIP) or allow both options. Participants who join the meeting via telephone dial a toll-based number that GoToMeeting provides automatically. Participants are then charged their standard long-distance rate for calling this toll-based number, just as if they made a regular long-distance call. Participants who join the meeting via VoIP need speakers or headphones to hear the GoToMeeting session and a microphone if you want them to speak. (We recommend a USB headset).

Audio details can be found in the Control Panel once the meeting starts. GoToMeeting will automatically generate a conference call number, access code and Audio PIN for all attendees joining via telephone.

You may decide to use the GoToMeeting integrated audio or choose another method of bringing audio to your online meetings.

**Note:** If you choose to use your own audio service provider for the audio portion of the meeting, GoToMeeting will include your dial-in numbers with the meeting information; however GoToMeeting audio features (such as VoIP and Control Panel audio management) do not apply.
Audio Mode: Using Telephone

At the specified meeting time, dial the conference call number. When prompted, enter the access code followed by the # key and then your unique Audio PIN. Once in a conference call, participants and organizers can enter commands using their phone keypads.

<table>
<thead>
<tr>
<th>Organizer Telephone Commands</th>
<th>Command</th>
<th>Feature</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>*2</td>
<td>Count</td>
<td></td>
<td>Provides the number of attendees dialed in to the conference.</td>
</tr>
<tr>
<td>*3</td>
<td>On-hold beep controls</td>
<td></td>
<td>Sets the on-hold beeps. Pressing *3 sets the following options:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• On-hold beeps on (default).</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• On-hold beeps off.</td>
</tr>
<tr>
<td>*4</td>
<td>Menu</td>
<td></td>
<td>Provides a menu of available conference commands.</td>
</tr>
<tr>
<td>*5</td>
<td>Listening Modes</td>
<td></td>
<td>Sets listening modes for the audience. Meeting organizers can cycle through three listening modes by pressing *5.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Mute: organizers and panelists can unmute themselves by pressing *6</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Mute: organizers and panelists cannot unmute themselves</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Unmute: organizers and panelists are unmuted (default)</td>
</tr>
<tr>
<td>*6</td>
<td>Mute/Unmute</td>
<td></td>
<td>Mutes the organizer's line. Pressing *6 again will unmute the line.</td>
</tr>
<tr>
<td>*8</td>
<td>Chime Controls</td>
<td></td>
<td>Sets entry and exit chimes. By default, entry and exit chimes are on. Pressing *8 cycles through the following options.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Entry chime and exit chime on (default)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Entry and exit chimes off</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Entry chimes off exit chime on</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Entry chime on exit chime off</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Attendees Telephone Commands</th>
<th>Command</th>
<th>Feature</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>*3</td>
<td>Exit</td>
<td></td>
<td>Exits the conference call.</td>
</tr>
<tr>
<td>*4</td>
<td>Menu</td>
<td></td>
<td>Provides a menu of available conference commands.</td>
</tr>
<tr>
<td>*6</td>
<td>Mute/Unmute</td>
<td></td>
<td>Mutes the participant's line. Pressing *6 again will unmute the line.</td>
</tr>
</tbody>
</table>

Turning entry and exit chimes on/off

In GoToMeeting entry and exit chimes are turned ON by default. Press *8 to cycle through the entry and exit chimes options using your telephone.

You may also turn chimes on and off through the control panel. Simply click Edit in the audio pane, and click Play Entry/Exit Chimes to toggle chimes on and off.
**Audio Mode: Using VoIP Checklist**

**Mic & Speakers Device Recommendations**

When using Mic & Speakers, audio quality can vary based on your audio software/hardware manufacturer as well as your operating system. The following table lists tested hardware devices in order of best quality to poor quality.

<table>
<thead>
<tr>
<th>Listed in order from best quality to poor quality</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><a href="image">USB* headset connected to your computer</a></td>
<td>Best</td>
</tr>
<tr>
<td><a href="image">Headphones and USB* microphone connected to your computer</a></td>
<td></td>
</tr>
<tr>
<td><a href="image">Analog** headset connected to your computer</a></td>
<td>Good</td>
</tr>
<tr>
<td><a href="image">Headphones and analog microphone** connected to your computer</a></td>
<td></td>
</tr>
<tr>
<td><a href="image">External speakers and analog microphone</a></td>
<td></td>
</tr>
<tr>
<td><a href="image">Laptop built-in microphone and speakers</a></td>
<td>Poor</td>
</tr>
<tr>
<td><a href="image">External speakers and USB Webcam microphone</a></td>
<td>Poor</td>
</tr>
</tbody>
</table>

*USB Cable **Analog Cable
Mic & Speakers Setup - PC Users

To select and test your Mic & Speakers

1. After you've logged into the session, select "Mic & Speakers" in the Audio pane of your Control Panel.
2. Click **Test**.

   a. Select a microphone from the drop-down list (a). Speak into your microphone: If the correct device is selected, the meter will light up green.

   b. Select speakers from the drop-down menu (b). Click **Play Sound**: If connected correctly, the meter will light up green and you will hear an audio track through your speakers.

   **Note:** If the green meters do not light up, select another device listed in the menu and repeat the test.

   c. The volume bar can be adjusted at any time during the session (c).

   **Note:** Advanced - Audio levels are automatically adjusted. We recommend you keep this checked. If you uncheck this selection, you must manually configure your audio settings through Windows Sounds and Audio Devices. If your attendees can't understand you because your voice is distorted, try un-checking "Microphone boost."

3. Click **OK**.
Audio Hardware Detection

If new audio hardware is plugged in during a session you will be prompted to use the device. If accepted, the application will automatically configure your audio preferences for the new hardware.

Mic & Speakers Setup - Mac Users

Mac users can select audio devices in-session only. Input and output devices connected to your computer are automatically detected.

To select and test your Mic & Speakers

1. You can select and test your audio devices through the Audio pane of the Control Panel. If your audio devices are connected correctly, you will see the sound meters in the control panel light up green.
2. If the meters for Mic or Speakers do not light up green when you or others are speaking, click on the icons in the Audio pane of the Control Panel. A drop-down menu will appear when you click either icon.
   - Microphone - To test, speak into your microphone; if the correct device is selected, the meter will light up green.
   - Speakers - To test, select a device from the drop-down menu. If connected correctly, the meter will light up green and you will hear an audio track through your speakers.
   - If the green meters do not light up, select another device listed in the menu and repeat the test.
   - Adjust speaker volume on your Mac keyboard.
Entry/Exit Chimes and On-Hold Beeps

GoToMeeting produces two different types of audio notifications that can be managed directly from the presenter's control panel or from the telephone. These notifications can be disabled if you or your attendees find them distracting.

To manage entry/exit chimes and on-hold beeps from the control panel

1. From the Audio pane in the presenter's control panel, click Edit. (a)
   - **Play On-Hold Beeps**: If this option is checked, you hear status beeps until the first attendee joins your meeting. (b)
   - **Play Entry/Exit Chimes**: If this option is checked, both organizer and attendees hear a chime every time an attendee enters or exits the meeting. (c)
**Integrated Toll-Free Audio**

GoToMeeting organizers now have the option to host meetings and Webinars with any combination of toll-based, toll-free and VoIP audio. Features like on-screen muting and integrated recording remain the same regardless of which audio option is selected.

Integrated toll-free audio is a separate service and has to first be enabled online by individual organizers or by your company’s GoToMeeting account administrator if you're a corporate user. An organizer's account incurs per-minute charges for each attendee dialing in through the Integrated Toll-Free audio service. At this time, the toll-free option is only available to callers within Canada and the United States.

As with existing meetings and Webinars, each session will have a unique toll-free number and access code. If you wish to re-use the same audio options for your meetings, select the **Recurring meeting** box in the Schedule a meeting window.

**Note:** For any Webinar, meeting or recurring meeting that was scheduled prior to an account's toll-free integration, the regular toll based conference numbers will automatically be changed if toll-free numbers are added to an already existing meeting or Webinar. It is recommended that you resend the meeting invitation and Webinar confirmation emails to your participants so that they get access to the new numbers. The meeting ID and URL for those meetings and Webinars will not be impacted and the new conference number will be provided to the attendees in the waiting room as well as the Control Panel.

**Calculating Toll-Free Minutes**

Per-minute charges apply to all participants who dial in with the toll-free option. Those who join by regular toll numbers are charged rates based on their own long distance provider. There are no additional charges for those who join a meeting or Webinar with VoIP audio.

To minimize billing, any attendee who joins a meeting or Webinar before the organizer starts the event is disconnected after 15 minutes of inactivity. If the meeting or Webinar is cancelled and never started by the organizer, then no charges are incurred. If, however, any organizer from the account joins the event, even if the meeting or Webinar is never actually started, the account is charged for the organizer's minutes, along with the minutes incurred by any attendees waiting for the event to start.

The organizer's company will be billed separately for toll-free audio by Citrix Online Audio, LLC.
Schedule a Meeting with Integrated Toll-Free Audio

To schedule a meeting with integrated toll-free audio

1. Right-click the icon in the system tray on a PC or double-click the GoToMeeting Suite icon on a Mac and select Schedule a Meeting.
2. Enter your email and password in the Login window, and click Log in.
3. Schedule your meeting as you normally would by including the subject, date and time.
4. To add a toll-free number to your meeting invitation, select the Edit Countries link, scroll to the bottom of the list and select the toll-free options you would like to provide. The toll-free number can be offered to your attendees along with VoIP and the traditional toll-conference option.

Note: Additional per-minute charges are incurred for each attendee dialing in with the toll-free service.
Schedule a Meeting with Toll-Free and VoIP

To offer your attendees a choice between two free audio options, simply ensure that the toll number has been deselected when you schedule the meeting.

Start a Meeting with Integrated Toll-Free Audio

Starting a meeting with integrated toll-free audio is the same as starting any other meeting, but with one key difference. Because the organizer is charged for each attendee dialing in with toll-free audio, accounts enabled with integrated toll-free audio will no longer permit attendees to talk amongst themselves until the organizer officially launches GoToMeeting. If an organizer is late to start the meeting, attendees will remain on hold and will hear the following greeting: "The organizer has not yet started the meeting. You will be placed on hold until an organizer starts GoToMeeting."

Countries with Integrated Toll-Free Audio

The GoToMeeting Integrated Toll-Free audio conferencing service includes the following international coverage.

<table>
<thead>
<tr>
<th>International Toll-Free Conference Numbers</th>
</tr>
</thead>
<tbody>
<tr>
<td>Australia</td>
</tr>
<tr>
<td>Austria</td>
</tr>
<tr>
<td>Belarus</td>
</tr>
<tr>
<td>Belgium</td>
</tr>
<tr>
<td>Brazil</td>
</tr>
<tr>
<td>Canada</td>
</tr>
<tr>
<td>China</td>
</tr>
<tr>
<td>Czech Republic</td>
</tr>
<tr>
<td>Denmark</td>
</tr>
<tr>
<td>Finland</td>
</tr>
<tr>
<td>France</td>
</tr>
</tbody>
</table>
Recording with Toll-Free Audio

Whether you or your attendees join with VoIP, toll or toll-free audio, you can easily and seamlessly record all participants. From the Recording section of the Preferences window, simply select Use GoToMeeting Audio Service. For more information about the Recording feature, please refer to Recording a Meeting on the GoToMeeting support site.

Toggle Audio Notifications

GoToMeeting produces two different types of audio notifications that can be managed directly from the presenter's control panel or from the telephone. These notifications can be disabled if you or your attendees find them distracting.

To manage entry/exit chimes and on-hold beeps from the control panel

1. From the Audio pane in the presenter's control panel, click Edit. (a)
   - Play On-Hold Beeps: If this option is checked, you hear status beeps until the first attendee joins your meeting. (b)
   - Play Entry/Exit Chimes: If this option is checked, then the organizer and attendees hear a chime every time an attendee enters or exits the meeting. (c)
Broadcast Computer Audio

While GoToMeeting is designed to efficiently broadcast voice audio over telephone or VoIP there may be times when you wish to broadcast an audio recording from your computer. In this section you will find audio configuration instructions that should allow you to transmit both your voice and audio from your computer. Due to some sound card limitations these procedures may not work with every system.

To configure Windows XP to broadcast audio

Note: Not all computers have a Stereo Mix option. Depending on your sound card, it may be called something else (like “What U Hear” on some Soundblaster cards) or may be absent entirely.

Note: You cannot use your microphone when switching via software.

1. Double-click the volume icon in the system tray (usually bottom-right of your desktop).
2. Select Options, then Properties.
3. Under Adjust Volume for choose Recording
4. Ensure Stereo Mix is checked.
5. Click OK.
6. On the Recording Control screen, select the checkbox under Stereo Mix.

To configure Vista or Windows 7 to broadcast audio

Note: Not all computers have a Stereo Mix option. Depending on your sound card, it may be called something else (like “What U Hear” on some Soundblaster cards) or may be absent entirely.

Note: You cannot use your microphone when switching via software.

1. Right-click the volume icon in the system tray (usually bottom-right of your desktop).
2. Select Recording Devices from the menu.
3. Right-click the first item on the list and ensure Show Disabled Devices is checked.
4. Ensure Stereo Mix is the default device.
5. Press OK.

Hardware Option

Parts needed

- Two (2) 3.5 mm audio splitters (one male, two female).
- One (1) 3.5 mm audio patch cable (two male ends, typically 3” long).

To configure your system to broadcast with hardware

1. Plug one splitter into your line out port (for speakers, typically colored green).
2. Plug the other splitter into your microphone port (typically pink).
3. Plug the patch cable into the splitter on line out and then into the splitter on microphone.
4. Plug your microphone into the microphone splitter, and then plug your speakers into the line out splitter.

Note: You may use your microphone and speakers simultaneously.
3rd Party Audio and HiDef Conferencing

When you schedule a meeting you can select which audio option works best for you and your attendees. If you choose to use a conferencing solution other than GoToMeeting integrated audio then all you have to do is include that information in the conference call field in the Schedule a Meeting dialog box.

Once scheduled, you will see your 3rd party conference number referenced in your meeting invitation, waiting room and the Audio pane in the presenter and attendee Control Panel.

Note: On-screen muting and VoIP audio are not available while using 3rd party audio solutions.

You can obtain a toll-free or international access conference call number through most conference call vendors. Note that there is often an additional fee for these numbers.

Citrix Online HiDef Conferencing™

Citrix Online now offers additional audio solutions including toll-free numbers through HiDef Conferencing which can be used with GoToMeeting. If you already have a HiDef Conferencing account then simply include your phone number and meeting room ID in the conference call field in the Schedule a Meeting dialog box.

If you wish to learn more about integrated toll-free audio service for GoToMeeting Corporate customers then please refer to Integrated Toll-Free Audio for details.
HDFaces Video Conferencing

GoToMeeting with HDFaces is a high-definition video conferencing technology that combines screen sharing, audio conferencing and video conferencing. Meeting participants can share up to 6 high-resolution video conferencing streams while viewing the presenter’s screen. A resizable viewer and customizable layouts allow you to adapt to numerous monitor and projection configurations. HDFaces is included with GoToMeeting at no additional cost. All you need is an Internet connection and a webcam to begin enjoying a telepresence-quality experience!

Share or stop webcams from the Control Panel

You and your attendees can share webcams in any of the following ways:

- Click the webcam button on the grab tab.
- Click the Share My Webcam button in the Webcam pane on the Control Panel.
- Select Share My Webcam from the Webcams drop-down menu.
- Click the webcam button next to your name in the Attendee List (PC-only).
- Right-click your own name in the Attendee List and select Share My Webcam.

Organizers can send Share Webcam Requests to attendees in any of the following ways:

- Click the Webcam column on the Attendee List.
- Right-click an attendee’s name from the Attendee List and select Send Webcam Request from the drop-down menu.
Organizers can turn off attendee webcams in any of the following ways:

- Click the green webcam button next to an attendee's name. Attendees will see a yellow tip or dialog indicating that the organizer has closed their webcam feed.
- Right-click an attendee's name from the Attendee list and select Stop Webcam Sharing.

Manage your webcam from your video feed

- Temporarily Pause/Play your video by selecting the Pause or Play button on the top-right corner of your webcam feed. (a)
- Resize the webcam viewer and screen sharing using the slider. You can click and drag any part of the slider to adjust the display. (b)
- When only webcams are being shared, participants can resize webcams by clicking and dragging the bottom-right corner of the Viewer. Expand and minimize how webcams and/or screen sharing is displayed by clicking and dragging the bottom-right corner of the viewer. If only webcams are being shared (not screen sharing), you can adjust the size and position of the webcam viewer by using the Webcams drop-down menu and selecting one of the following Webcam Positions: Top, Left, Bottom, Right.
Toggle the webcam layouts

Attendees can change the webcam position from the **Webcams** drop-down menu located in the top-left corner of the viewer or the Webcam pane in the Control Panel (only available when both webcams and screen sharing are enabled).

- **Share My Webcam** - Shares your own webcam.
- **Stop Sharing My Webcam** - Stops broadcasting your own webcam.
- **Hide Webcams** - Hides the webcam viewer but still broadcasts your webcam feed to other attendees.
- **Always in Front** - Keeps webcams on top of all other applications and windows (only available for PC organizers and all Mac participants). Hiding webcams decrease bandwidth consumption.
Remove webcams for all participants

From the Options menu, organizers can uncheck the *Attendees Can Share Webcams* setting to remove the option for all meeting participants to share webcams.

Manage your webcam settings

1. Click the **File** menu and select **Preferences**, or right-click the GoToMeeting daisy icon 🌼 from your **system tray** and select **Preferences**. Preferences can also be found on the **Webcams** drop-down menu in the Webcam pane or viewer.
2. From the **Preferences** window, select the **Webcam** option from the left-navigation menu to view the following:
   - **Your camera** - Shows the make and model of your detected webcam.
   - **Select a display format** - Adjusts the aspect ratios of webcam feeds. 4:3 is the normal display and 16:9 is the widescreen display.
   - **Advanced** - Modifies your hardware settings from within GoToMeeting. Customizable options depend on your webcam manufacturer.
Start/End a Scheduled Meeting

Scheduled meetings are any GoToMeeting sessions that have been previously scheduled by the organizer in the GoToMeeting application.

Scheduled GoToMeeting sessions can be started from the GoToMeeting PC system tray icon, the Mac GoToMeeting Suite icon, the GoToMeeting Web site and the GoToMeeting Outlook bar.

**Note:** To start a meeting the GoToMeeting application must be installed on the PC or Mac being used by the meeting organizer. For more information on installing the GoToMeeting application please see the GoToMeeting Install GoToMeeting section.

Start a Scheduled Meeting from Your Desktop

To start a scheduled meeting from your desktop

1. Right-click the icon in the PC system tray or double-click the GoToMeeting Suite icon on a Mac and select **My Meetings**.
2. Enter your Email and Password in the **Login** window, and click **Log In**.
3. On the **My Meetings** window, select the meeting you want to start by selecting the name in the Subject column and then click the **Start** button.

Your meeting will start and the GoToMeeting Organizer Control Panel will appear on the right side of your desktop.
Start a Meeting from the Web

To start a scheduled meeting from the GoToMeeting website

2. On the My Meetings page, locate the scheduled meeting you wish to start and click the Start Meeting button.
3. If prompted, click Yes or Grant to accept the GoToMeeting download.

Your meeting begins and the GoToMeeting Organizer Control Panel appears in the right side of your desktop. Please see the Organizer Control Panel section for more information.

Start a Meeting from Outlook

To start a scheduled meeting from the GoToMeeting Outlook bar

1. From the GoToMeeting toolbar in Outlook, click the GoToMeeting button and select My Meetings.
2. On the Login window, enter your Email and Password and click Log in.
3. On the My Meetings window, select the meeting you want to start by clicking the name of the meeting in the Subject column, and click the Start button.

Your meeting begins and the GoToMeeting Organizer Control Panel appears in the right side of your desktop. Please see the Organizer Control Panel section for more information.

Note: If the GoToMeeting toolbar does not appear in your Microsoft Office application, see the GoToMeeting Application Preferences section for instructions.
Start a Meeting from IBM Lotus Notes

To start a scheduled meeting from the GoToMeeting IBM Lotus Notes Actions menu

1. From the Actions menu in the Lotus Notes toolbar, select My GoToMeetings.
2. On the Login window enter your Email address and Password and click Log In.
3. On the My Meetings window, select the meeting you want to start by clicking the name in the Subject column, and click the Start button.

Your meeting will start and the GoToMeeting Organizer Control Panel will appear on the right side of your desktop. Please see the Organizer Control Panel section for more information.

Start a Meeting from Microsoft Office

To start a scheduled meeting from the GoToMeeting Toolbar in Microsoft Office

1. From the GoToMeeting toolbar in Microsoft Office, click the GoToMeeting button and select My Meetings.

On the Login window, enter your Email address and Password and click Log In.

2. On the My Meetings window, select the meeting you want to start by clicking the name in the Subject column, and click the Start button.

3. Your meeting will start and the GoToMeeting Organizer Control Panel will appear in the right side of your desktop. Please see the Organizer Control Panel section for more information.

Note: If the GoToMeeting toolbar does not appear in your Microsoft Office application, see the GoToMeeting Application Preferences section for instructions.
Start an Impromptu Meeting

Start an Impromptu meeting at any time without having to schedule them in advance. The Meet Now feature is for last-minute or on-the-fly meetings that need to occur without prior notice. Impromptu meetings may be initiated either from the GoToMeeting PC system tray icon, the Mac GoToMeeting Suite icon, from the Microsoft Outlook tool bar, the Lotus Notes Actions menu or from an integrated instant-messaging application.

Start a Impromptu Meeting from your desktop

1. Right-click the 🌱 icon in the PC system tray or double-click the GoToMeeting Suite icon on a Mac and select Meet Now.
2. On the Login window, enter your Email address and Password and click Log In.
3. Your meeting starts and the GoToMeeting Organizer Control Panel appears in the right side of your desktop. Conference call information appears in the meeting information pane of the Organizer Control Panel.

Or

1. Double-click the 🌱 icon in the PC system tray.
2. Your meeting starts and the GoToMeeting Organizer Control Panel appears on the right side of your desktop. Conference call information appears in the meeting information pane of the Organizer Control Panel.

Start an impromptu meeting from the Web

1. Go to www.gotomeeting.com and click the Host a Meeting button.
2. If prompted, click Yes or Grant to accept the GoToMeeting download.
3. On the Login window, enter your Email address and Password and click Log In.
4. On the Host a Meeting window, select Meet Now.
5. Your meeting starts and the GoToMeeting Organizer Control Panel appears on the right side of your desktop. Conference call information appears in the meeting information pane of the Organizer Control Panel.

Start an impromptu meeting from Outlook

1. From the GoToMeeting Outlook bar, click the Meet Now button.
2. On the Login window, enter your Email address and Password and click Log In.
3. Your meeting will start and the GoToMeeting Organizer Control Panel will appear in the right side of your desktop. Audio information appears in the meeting information pane of the Organizer Control Panel.
Start an Impromptu Meeting from Microsoft Office

To start an impromptu meeting from the GoToMeeting Toolbar in Microsoft Office

1. From the GoToMeeting Toolbar in Microsoft Office, click the Meet now within button to launch an impromptu meeting.
2. On the Login window, enter your Email address and Password and click Log In.
3. Your meeting starts and the GoToMeeting Organizer Control Panel appears in the right side of your desktop.
4. Click the Show My Screen button and your presentation starts in specific application-sharing mode. This means that GoToMeeting only displays the Microsoft Office window from which you started the impromptu meeting.

Note: The GoToMeeting toolbar can be displayed in Microsoft Word, Excel and PowerPoint.

Start an Impromptu Meeting from IBM Lotus Notes

To start an impromptu meeting from the IBM Lotus Notes Actions menu

1. From the Lotus Notes menu options under the Actions menu, select Meet Now with GoToMeeting.
2. On the Login window, enter your Email address and Password and click Log In.
3. Your meeting will start and the GoToMeeting Organizer Control Panel will appear in the right side of your desktop. Audio information appears in the meeting information pane of the Organizer Control Panel.

Start an Impromptu Meeting from an Instant-Messaging Application

To start an impromptu meeting from an instant-messaging application

1. Launch the instant-messaging application.
2. Open a chat communication with the attendee you would like to meet.
3. In the Title bar, click the GoToMeeting Messenger Button and select Meet Now.
4. On the Login window, enter your Email address and Password and click Log In.
5. Your meeting starts and the GoToMeeting Organizer Control Panel appears in the right side of your desktop. Audio information appears in the meeting information pane of the Organizer Control Panel.
Leave or End a Meeting

Organizers may choose to either leave a meeting while allowing the meeting to continue, or to end a meeting completely.

**Note:** If an organizer chooses to leave a meeting while allowing the meeting to continue he or she must first make another attendee an organizer for the meeting.

**To leave a meeting and allow the meeting to continue**

1. From the *File* menu, select *Leave Meeting*.
2. Click **Choose an Organizer & Leave** and then promote an attendee from the drop down list to organizer.

![Leave Meeting or End Meeting? - GoToMeeting](image)

**Note:** If you leave a meeting running that you started, you will not be allowed to host or join another meeting until the first meeting is finished.

**To end a meeting**

1. From the *File* menu, select *End Meeting*.
2. On the *End meeting for everyone?* confirmation dialog box, click **Yes**.
The Organizer/Presenter Control Panel

When the organizer first joins the meeting the Presenter Control Panel appears on the right side of the desktop. The Presenter Control Panel gives organizers and presenters access to various organizer and presenter functions. The Presenter Control Panel is comprised of four panes: Screen Sharing, Attendee List, Audio, Chat and the Grab Tab. The Organizer Control Panel has a sixth pane, the Recording pane, which can be displayed by selecting View and then Recording from the Organizer Control Panel Menu Bar.

Note: When the Organizer passes the Presenter role to another attendee, the Control Panel changes and the Screen Tools section is removed and given to the new presenter.

- The **Screen Sharing pane** provides organizers/presenters with a visual reminder of On Air status, as well as the ability to show their screens, pause showing their screens, pass keyboard control and change presenters. (a)
- The **Grab Tab** enables organizers/presenters to minimize the Control Panel to the side of their desktops to display their full desktops to attendees and still access Presenter Screen Tools. (b)
- The **Recording pane** gives PC-based organizers/presenters the ability to record meetings. (c)
- The **Attendee List pane** provides organizers/presenters with a list of all meeting attendees and enables them to make other attendees organizers or presenters, grant or revoke attendee privileges and dismiss attendees. This pane also provides a handy way to invite more attendees. (d)
- The **Audio pane** provides access to the audio settings for organizers/presenters and attendees. (e)
- The **Webcam pane** provides organizers and attendees ability to broadcasting up to 6 high-resolution video conferencing streams while sharing your screen. (f)
- The **Chat pane** allows organizers and attendees to communicate privately or publicly and share websites. (g)
**Screen Sharing Pane**

When an attendee becomes a presenter, the Control Panel adjusts to incorporate the Presenter Screen Sharing pane at the top. The Screen Sharing pane provides the presenter with access to the various presentation controls.

- The *Broadcasting Status* field notifies presenters of the status of screen sharing.  
  
- The *Show My Screen* button starts or pauses a presenter’s ability to show the entire desktop to attendees.  
  
- The *Screen* drop-down button allows the presenter to share specific application windows, or a clean screen with meeting attendees.  
  
- The *Give Keyboard & Mouse* button grants shared mouse and keyboard control to another attendee.  
  
- The *Change Presenter* button passes the presenter role to another attendee.

**Share Your Desktop**

1. Click the *Screen* button on the GoToMeeting Control Panel.  
2. Select the preferred screen setting or a specific application.

---

**Note:** Hovering over your *Show Only* menu selection will display an animated gray frame which indicates what attendees will see if selected. If you select an application window that is minimized, the selected window will automatically maximize and be presented to attendees. If the presenter opens a window on top of the window being shared, screen sharing will pause until the intruding window is either moved or closed.

**Note:** The specific application sharing feature will also allow you to share one or all of your multiple monitors if you have the hardware already set up.

**Note:** To change the background color of a CLEAN screen presentation, simply right-click on your desktop while you’re in that mode and pick from the available colors.

**Note:** If you are attempting to show a PowerPoint presentation and your screen will not advance to the next slide, click the PowerPoint presentation displaying on-screen to bring it back into focus, then try again.
Mac presenters do not have the option of displaying a clean screen or a specific application. We recommend you close any windows that you do not want attendees to see before beginning screen sharing.

**Pass Roles to Attendees**

Your keyboard and mouse controls can be temporarily shared with one of your attendees or the entire group. Simply click the **Give Keyboard & Mouse** button on the *Screen Sharing* pane or the Grab Tab and then select the attendee. As the presenter you will always have priority control of your keyboard and mouse, and can regain control simply by hitting a key or moving your mouse.

If you would like to pass the presenter role to one of your attendees, simply click the **Change Presenter** button on the *Screen Sharing* pane or the Grab Tab and select the new presenter.

To return the presenter role to yourself, click the **Change Presenter** button again and select your own name.

**Request Keyboard and Mouse**

Organizers and panelists can request keyboard and mouse control from the presenter. Right-click or Control-click your name in the *Attendee List* pane and select **Make Presenter**.
Manage Attendees

Organizers can manage attendees by right-clicking or Control-clicking attendee names in the Attendee List pane and selecting or deselecting the desired attendee options.

- Displays the number of attendees and maximum number of attendees for the meeting (a)
- Indicates attendee role and color of assigned drawing tool (b)
- Mute or unmute the attendee (c)
- Mute or unmute all the attendees (d)
- Assign an attendee the role of presenter and/or organizer (e)
- Share your keyboard and mouse with an attendee (f)
- Provide an attendee with on-screen drawing tools (g)
- Choose pen color for yourself or your attendees (h)
- Allow your attendee to see the list of other attendees (i)
- Allow your attendee to chat (j)
- Sends a chat message directly to the attendee (k)
- Copy the attendees email address to the clipboard (l)
- Dismisses an attendee from the meeting (m)
Manage Audio

When attendees join the audio portion of your meeting, they are unmuted by default. Attendees who connect via VoIP will have a microphone icon next to their name; attendees who connect via telephone will have a handset icon next to their name. For more information on audio options, please see GoToMeeting Integrated Audio.

Note: Organizers should be aware that attendees joining with VoIP will not be able to participate in the audio portion of the meeting until the meeting is started. Attendees joining by telephone can communicate with other attendees at any time regardless of whether or not the meeting has started.

Audio PIN

Everyone who joins a meeting is provided a unique Audio PIN that, when entered, gives an organizer and attendee muting and unmuting control. Those joining by VoIP automatically have the Audio PIN assigned to them. Those joining by telephone are prompted to enter their Audio PIN when they first dial in. This unique PIN is displayed in the GoToMeeting waiting room as well as in the Audio pane of the Control Panel.

An Audio PIN can be entered on the telephone at anytime during the meeting by entering the # key, then the Audio PIN, followed by the # key a second time.

Attendees Audio

- This example shows that the presenter joined via telephone entered his Audio PIN and is currently unmuted. (a)
- This attendee joined via telephone but did not enter her Audio PIN. (b)
- This attendee joined via VoIP and is unmuted. (c)
- Attendees who join the meeting via telephone must enter their Audio PIN so that you have full audio controls through the Organizer Control Panel. If not entered, you can right-click the person's name and select Send Audio PIN. This will send a pop-up message with the Audio PIN to that person. (d)
On-Hold Beeps and Entry/Exit Chimes

*On-Hold Beeps* (a) play when an attendee connects to a meeting before the organizer has started it, unless the organizer disables the beeps.

*Entry/Exit Chimes* (b) play each time an attendee joins or leaves the meeting, unless the organizer turns the chimes off.

To toggle *On-Hold Beeps* or *Entry/Exit Chimes* on and off, click the **Edit** button in the **Audio** pane, then click each item to turn it on or off.
## Audio Control Icons

<table>
<thead>
<tr>
<th>Audio Control Icons</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Telephone: Unmuted (default)</td>
<td>Can mute/unmute self through Control Panel or telephone keypad (*6)</td>
</tr>
<tr>
<td>Telephone: Muted</td>
<td></td>
</tr>
<tr>
<td>Telephone: Did not enter Audio PIN or has not yet joined the audio portion of the meeting. Cannot mute/unmute attendee until Audio PIN is entered.</td>
<td></td>
</tr>
<tr>
<td>VoIP: Unmuted (default)</td>
<td>Can mute/unmute self through Control Panel</td>
</tr>
<tr>
<td>VoIP: Muted</td>
<td></td>
</tr>
<tr>
<td>No icon</td>
<td>Not connected to audio (cannot hear audio or speak).</td>
</tr>
</tbody>
</table>
Organizer Audio

GoToMeeting integrated audio allows you to manage audio options before and during your meetings. If you wish to change your own connection or your attendees’ audio connection during a meeting, you can do so from the Audio pane of your Control Panel. For more information about audio options, please see GoToMeeting Integrated Audio.

Starting the Meeting

VoIP and Telephone: If you have selected to use VoIP and Telephone for your meeting, you will see the options Telephone and Mic & Speakers in the Audio pane. The default mode is Telephone; however, GoToMeeting will remember your selection for your next meeting.

Telephone: If you selected Telephone only for your meeting, you must join the audio portion by dialing the conference number and entering the access code and Audio PIN noted in the Control Panel.

To switch audio formats during a meeting

If you are using the GoToMeeting Conference Call Service during a meeting, you can switch between using Mic & Speakers or Telephone. In the Audio pane at Audio Mode, click either Telephone or Mic & Speakers.
To edit audio services for your attendees

If you would like to provide your attendees different conference call options during a meeting, you may do so by clicking the **Edit** button in your **Audio** pane, then clicking **Edit Audio Mode**.
Muting Audio

With GoToMeeting integrated audio, you can manage the muting and unmuting of individual attendees, switch audio formats and keep track of who is speaking. For more information about audio options, please see GoToMeeting Integrated Audio.

▶ To manage muting and unmuting during a meeting

You can mute/unmute yourself and attendees in the following ways:

- Click the microphone icon on the Grab Tab to mute yourself. (a)
- Click the microphone or handset icon next to any name in the attendee list. (b)
- Right-click a name in the attendee list and select the Mute option. (c)
- Click the Mute All button to mute all attendees. (d)
Chat with Attendees

As an organizer, you can chat with your attendees by using the built-in Chat feature in the Chat pane. This feature can be turned on or off from the Meetings tab in the Preferences window or during a meeting from the Attendee List pane.

- The Chat Log displays the text of all public chat and chat between two attendees. (a)
- Share websites with attendees for easy navigation. (b)
- The Message Entry field enables input of chat text. (c)
- Send your chat message to all attendees or a specific attendee from the drop-down selection field. (d)
- The Send button transmits chat to selected recipients. (e)
- Create a welcome message to be delivered to attendees when they arrive. (f)

Mac organizers can edit welcome messages from the File drop-down menu in the toolbar.
Invite Attendees During a Meeting

As an organizer, you can invite new attendees to meetings that are already in progress from the Attendee List pane. Invitation methods include phone, email and copy/paste.

► Invite attendees by phone

To invite attendees by phone, call the desired attendees and direct them to JoinGoToMeeting.com. Next, read them the meeting ID which can be found in the Invite Others window or at the bottom of your Control Panel.

► Invite attendees by email

To invite attendees by email, click the Invite Others button from the Attendee List and then click the Email button.

A new Microsoft Outlook or IBM Lotus Notes email will be generated with the meeting invitation information in the body of the email; simply enter the email address and send the email to the desired attendees.

Note: The email option works with Microsoft Outlook, IBM Lotus Notes and most PC based Email clients. If your Email application is not supported then simply click the Copy to Clipboard button and paste the meeting information into your email service. See Integration Preferences to learn more about Email integration.

► Copy and paste the invitation

To invite attendees using an email service other than Microsoft Outlook, click the Invite Others button from the Attendee List and then click the Copy to Clipboard button.

This will copy the meeting invitation information to your clipboard, where it can then be pasted into another Email program or an instant-messaging application.
Grab Tab

The Control Panel Grab Tab enables organizers and presenters to minimize the Control Panel and still access Presenter Screen Tools. There are four main display modes:

1. Attendees have arrived and the presenter is displaying his or her desktop and webcam.
2. Attendees have arrived and the presenter has paused displaying his or her desktop. In this mode, screen sharing is paused and attendees see a frozen image of the presenter's desktop. The presenter is still sharing the webcam.
3. Attendees have arrived and the presenter has paused displaying his or her desktop. In this mode, screen sharing is paused and attendees see a frozen image of the presenter's desktop. The webcam has been disabled.
4. Attendees have arrived and the presenter has stopped displaying his or her desktop. In this mode, screen sharing is stopped and attendees return to the waiting room.
5. The organizer/presenter has started meeting but no attendees have arrived.
   - Click and drag to move Grab Tab up or down (a)
   - Hide or display Control Panel (b)
   - Mute or unmute the microphone or telephone from attendees. (c)
   - Share or disable your webcam (d)
   - Displays desktop to attendees (e)
   - Pause your desktop so the desktop remains frozen (f)
   - Give Keyboard & Mouse button grants shared mouse/keyboard control to another attendee (g)
   - Pass the presenter role to another attendee (h)
   - Draw, highlight and place arrows on the screen, as well as use the spotlight and clear all markings (h)
Drawing Tools

The Drawing Tools feature is accessed from the Drawing Tool button on the GoToMeeting Grab Tab. Once a drawing tool is enabled, the Drawing Tools menu can be reselected by either clicking the Drawing Tool button or by right-clicking your mouse. To deactivate a tool, simply select Normal non-drawing mode from the menu.

- No drawing tool selected (a)
- Click and drag to draw on the screen (b)
- Click and drag to highlight in yellow (c)
- Allows the presenter to draw attention to an area of the screen without leaving a mark (d)
- Places an arrow on the screen (only one arrow at a time) (e)
- Erases all presenter and attendee drawings (f)
- Enables Attendee Drawing Tools during a meeting (g)
- Customize the color of the pen tool. (h)

Note: Press the Shift key with any drawing tool to make a straight line.

Note: Only the presenter can erase drawings. Drawing will pause for attendees anytime the presenter pauses the presentation.

The Drawing Tools feature is currently only available for meetings hosted by PC users.
Choose Pen Color

The Drawing Tool feature can be customized to display a preferred pen color while interacting with the screen. Once enabled, you and your attendees can modify the pen color either from the Drawing Tool button on the Grab Tab or by right-clicking on a name in the attendee list.
Menu Bar - PC Users

The Organizer Control Panel menu bar provides access to various application tools not specifically related to managing meetings. Menu options include File, Options, View and Help.

File Menu

From the File menu, PC-based organizers can edit how their names and email addresses are displayed to attendees. They can change the meeting subject, save the chat logs of their meetings as .rtf files to their PCs and access Preferences while in session. Organizers can also exit meetings without ending them (they must first make another attendee an organizer) or exit meetings and end them.

Options Menu

From the Options menu, organizers can enable or disable the Attendee List and/or Chat feature for all attendees.

View Menu

From the View menu, organizers can record the meeting. Organizer can also return the Control Panel layout to its default settings or save the current layout.

With Auto-Hide the Control Panel checked your Control Panel is set to collapse automatically after 10 seconds of inactivity. To disable this feature, deselect the Auto-Hide the Control Panel option in the View menu.

Help Menu

The Help menu provides access to the online GoToMeeting help file, Audio Feedback and GoToMeeting software version information.
Toolbar - Mac Users

GoToMeeting Menu
The GoToMeeting menu allows Mac-based organizers to manage their preferences and end a meeting.

File Menu
The File menu allows organizers to edit how their names and email addresses are displayed to other attendees, save the meeting chat logs as .html files and leave meetings.

View Menu
The View menu enables organizers to select how to display the Viewer Window on their desktops.

Audio Menu
The Audio menu provides organizers another option for managing their audio settings. They can mute themselves, switch between telephone and VoIP if enabled and select their audio input/output.

Help Menu
The Help menu provides access to the online GoToMeeting help file and to GoToMeeting software version information. There is also an option to leave feedback on the audio quality.
Record and Play a Meeting

Notes on Recording and Playing a Meeting

Meeting recording allows an organizer to record all screen activity that is presented in the GoToMeeting Viewer Window, including desktop and application sharing of other attendees presenting during the meeting.

**Note:** Although you can record screen sharing and audio, you cannot record webcams at this time.

See the System Requirements section of this guide for requirements to record a meeting.

Before recording a meeting, an organizer must set recording preferences, including selecting the audio format and recording media format (either GoToMeeting format or Windows Media Player format). If the Windows Media Player format is selected, GoToMeeting will begin an automatic conversion process immediately after a meeting has ended. Allow time for the conversion to take place. The time needed is dependant upon video content, CPU speed and amount of memory available.

To record the audio portion of your session, an organizer must have a sound card installed on his or her computer. To record using the GoToMeeting integrated audio feature, an organizer can use the telephone or a microphone connected to his or her computer. To record using the organizer's private audio service, an organizer must have a phone patch connected to both the phone and the "mic in" port of his or her computer.

Only one recording file is created per meeting. This means that if an organizer clicks Record to start the recording, then stops the recording and subsequently restarts the recording during the course of one meeting, GoToMeeting will continue recording to one meeting recording file.

The default destination location to save a recording defaults to the My Documents folder. An organizer can change the destination location but only before beginning recording. It is recommended that the designated location have a minimum of 1 GB of free space in order to accommodate the recording. For optimum recording performance and in-session experience, it is recommended that you select a location on your local hard drive.
Record a Meeting

The Desktop Recording and Meeting Playback feature is only available to meeting organizers or promoted organizers.

Note: Although you can record screen sharing and audio, you cannot record webcams at this time.

Note: To avoid a recorded meeting with a blank screen, please ensure the presenter initiates some type of screen action (such as advancing a presentation slide) after clicking the Start Recording button. If recording begins before the presenter shares his or her screen and there is no screen action then the finished recording will only include a blank screen and audio.

The Desktop Recording and Meeting Playback feature is only available to PC-based meeting organizers or promoted organizers.

To configure recording settings

1. From the Recording pane click the Settings link.

2. From the Recording Preferences section:
   - Audio - Allows you to enable or disable the audio recording feature. To record, choose which audio service you want to use for your meeting.
     Note: Be sure to check your audio device settings under Audio in the left menu.
   - Video - Allows you to select the meeting recording output format and destination for saving the file.
     Note: Mac users can only view meetings recorded in Windows Media Player format.
   - Save in - Select the folder in which you want to save your recording.
3. Click **OK**.

**Note:** If you are using VoIP, see the GoToMeeting Integrated Audio section for information on testing your audio device.

**Note:** For optimum recording performance and in-session experience, it is recommended that you select a location on your local hard drive.

**Note:** You cannot change the input device setting or the "Save in" location setting once you have started to record a meeting. If you do not specify a destination location, the default is My Documents.
To record a meeting

1. Click Settings in the Recording pane and confirm that your Audio and Video options are set appropriately. For detailed Audio and Video options, click on the Need Audio Help link and Learn More links respectively.
2. In the “Save in” section, click the Browse button to identify where you would like to save your recording.
3. Click OK to save your settings.
4. In the Recording pane, click the Start Recording button to begin recording.
5. Click Show My Screen to capture the video portion of the recording.
6. Click File and select Exit - End Meeting.

Note: Although you can record screen sharing and audio, you cannot record webcams at this time.

Note: The lower you set your monitor resolution, the better the quality of the meeting recording. A resolution of 1024 x 768 is ideal for optimal recording quality. Since the recording will scale to the highest resolution among the presenters in a recorded meeting, it is also recommended that all presenters synchronize their resolution settings to the same setting. Avoid displaying multiple monitors when recording a meeting.

Note: You must have at least 500 MB of space on the destination drive to record a meeting. If you have less than 500 MB of available space, GoToMeeting will display a warning when recording begins. If space drops to 100 MB, recording will be automatically stopped and you will receive a warning message. If you have selected to convert your recording to Windows Media format, you will need 1 GB (twice as much space). The Remaining field in the Recording pane refers to the amount of space available for recording that is listed in the Recording Preferences Save In field.
Play a Recorded Meeting

GoToMeeting creates one recording file per meeting. If you stop and start a recording during the course of a meeting, each recorded segment will be appended to the recording file in progress for that meeting.

To replay a meeting recorded in the GoToMeeting format

1. If you haven't already, end the meeting that you are recording and GoToMeeting will automatically save your file with the date and time noted after the name that you gave the meeting upon scheduling it. Impromptu meetings will be named with the date and time of the meeting followed by Meet Now.
2. Navigate to the directory that is listed in the Save in: field under the Preferences Recording tab.
3. Click the file name to start the replay.
4. Press Alt and Enter on your keyboard at the same time to maximize the Viewer Window for best replay quality.

Note: You must have GoToMeeting installed, or download the GoToMeeting codec to view a meeting recorded in the GoToMeeting format. Visit https://www1.gotomeeting.com/codec to download the codec. Mac users cannot view meetings recorded in GoToMeeting codec format.

Note: Playing a recorded meeting back before ending the meeting may cause abnormal playback behavior. Be sure to end the meeting before playing it back.

To replay a meeting recorded in the Windows Media format

1. If you haven't already, end the meeting that you are recording.
2. GoToMeeting will save your file with the name that you gave the meeting upon scheduling it or Meet Now plus the date and time of the meeting and will immediately begin converting the recording file into the Windows Media format.
3. Upon completion of the conversion process, navigate to the directory that is listed as the Save in: field under the Preferences Recording tab.
4. Click the file name to start the replay.
5. Press Alt and Enter on your keyboard at the same time to maximize the Viewer Window for best replay quality.

Note: The conversion process begins automatically, immediately after you end a recorded meeting in the Windows Media format. Allow time for the conversion to take place. The time needed is dependant upon video content, CPU speed and amount of memory available. Due to the use of CPU resources, you may have to wait until the conversion process is complete to resume use of the computer. GoToMeeting converts the recorded meeting into a Windows Media Player file after the meeting is over, instead of recording directly to Windows Media format. This ensures that, the impact on CPU resources doesn't bog down the computer during the meeting.

Note: Playing a recorded meeting back before ending the meeting may cause abnormal playback behavior. Be sure to end the meeting before playing it back.
Distribute a Recorded Meeting

Depending on the size, meeting recordings can be zipped and sent by email, sent by FTP or posted on a website.

To distribute a recorded meeting in the GoToMeeting format

1. Deliver the recorded meeting by email or FTP or post to a website.
2. Recipients must have Windows Media 9 or higher to view the recorded meeting.
3. Ask recipients to install the GoToMeeting codec at http://www.gotomeeting.com/codec if not already installed or if recipients are not running the GoToMeeting software on their computers.

To distribute a recorded meeting in the Windows Media format

1. Upon completion of the conversion process, deliver the recorded meeting by email or FTP or post to a website.
2. Recipients must have Windows Media 9 or higher to view the recorded meeting.
**Edit a Recorded GoToMeeting Recording**

Since GoToMeeting does not include editing software, a third-party editing tool such as TechSmith Camtasia® is needed to edit your recorded meeting or Webinar. Before you can edit the recording however, you will first need to re-encode the file with a tool such as Microsoft's Expression Encoder.

### Re-encode with Expression Encoder

**To download and install Microsoft's Expression Encoder**

1. Click this link: [Expression Encoder](#).
2. Click **Download** on the Microsoft Expression Encoder web page.
3. Click **Run** or **Install** at the prompt.
4. Click **Run** at the Security Warning prompt.
5. Follow the Setup Wizard to complete installation.

**To re-encode your recording using Expression Encoder**

1. Open Expression Encoder.
2. From the **File** menu, select **Import** and navigate to your recording.
3. Locate the **Encode** tab on the right-side of your screen and expand the **Video** pane.
4. Configure the settings as needed but we recommend setting the **Video Output Format** to **VC-1 Main**.
5. We also recommend setting **Size Mode** and **Video Aspect Ratio** to **Source**.
6. Select the **Output** tab and choose a location for the saved file.
7. Choose **Encode** from the **File** menu. Processing time will depend on length of recording, output settings and your system hardware. Once re-encoded the file is ready for editing.
Locate a Recorded GoToMeeting, GoToWebinar or GoToTraining

When you record a meeting, webinar or training, the recording is saved on the same computer from which you hosted the session. You must be present at this computer to locate your recording.

**Note:** Meetings are not recorded automatically. You must click the **Start Recording** button on the GoToMeeting, GoToWebinar or GoToTraining control panel in order to record your session. See [Record a Meeting](#) for more information.

▶ Find your saved recordings

The location of your recorded sessions can be managed from the **Preferences** menu.

**Note:** The default location for recorded meetings is the **My Documents** folder.

1. Right-click the 📁 icon in your system tray and select **Preferences**.
2. Select the **Recording** category in the left-hand menu.
3. The location of your recorded meetings is available at the bottom of the screen.
Locate your recording in the folder

1. Navigate to the same folder listed in the Recording preferences window.
2. The saved .wmv file includes the date, time and title of your meeting.

In the example below the recorded meeting was held 12/28/10 at 10:04. The name of the meeting was Example. The file name for this meeting is 2010-12-28 10.04 Example.wmv.

Download Windows Media Player

In order to record a meeting, you must have Windows Media Player 9 or newer.

To download Windows Media Player

1. Go to the Microsoft Windows Media Website, and follow the prompts to download the most recent version of Microsoft Windows Media Player.

Note: Meeting recording requires Windows Media Player 9.0 or higher. Windows Media Player 9.0 currently supports Windows® 2000, XP Home, XP Pro and 2003 Server; therefore, these are the operating systems required for recording with GoToMeeting.
Attending Meetings

Attendee Role Overview

- A meeting attendee can be any person with an Internet connection. All that is needed to join a meeting is the meeting ID and, if required, the meeting password. Attendees do not need to subscribe to GoToMeeting; they meet at no cost to them as guests of the organizer.
- Attendees may be given the role of organizer and/or presenter from the original meeting organizer at any time once a meeting has started.

Join a Meeting

There are several ways to join a meeting depending on how you receive the meeting invitation. Joining a meeting requires no pre-registration or configuration.

Note: When joining a meeting, remember to also conference into the meeting using the conference call information provided by your meeting organizer.

To join a meeting from an email invitation, Outlook or Lotus Notes meeting appointment or instant message

1. Open the email, appointment or instant message that contains the meeting invitation.
2. Click the link provided in the email to join the meeting.
3. If prompted, click Yes, Grant or Trust to accept the download.
4. If requested, enter the meeting password provided by your meeting organizer.
5. When prompted, type in your name and optionally, your email address.

Upon clicking OK in the Name and Email dialog, you will be entered into the meeting. The Attendee Control Panel and the GoToMeeting Viewer window will appear.

To join a meeting from the GoToMeeting web site

1. Open an Internet browser and go to www.gotomeeting.com
2. Click the Join Meeting button.
3. If prompted, click Yes, Grant or Trust to accept the download.
4. On the Join a Meeting window, enter the meeting ID you received from your meeting organizer.
5. If requested, enter the meeting password provided by your meeting organizer.
6. When prompted, type in your name and optionally, your email address.

Upon clicking OK in the Name and Email dialog, you will be entered into the meeting. The Attendee Control Panel and the GoToMeeting Viewer window will appear.
To join a meeting from your desktop

1. If you are an organizer and GoToMeeting is already installed on your computer, you can right-click the icon in the PC system tray or double-click the GoToMeeting icon on a Mac and select Join a Meeting.
2. On the Join a meeting window, enter the meeting ID you received from your meeting organizer.
3. If requested, enter the meeting password provided by your meeting organizer.
4. When prompted, type in your name and optionally, your email address.

Upon clicking OK in the Name and Email window, you enter into the meeting. The Attendee Control Panel and the GoToMeeting Viewer window appear.
To join a meeting from your iPad, iPhone or iTouch

1. Download and install the GoToMeeting App.
2. Open the GoToMeeting app.
3. Enter the meeting ID provided to you by the organizer.
4. Enter your name, email and press Join.
5. Once you press join, you will connect to the meeting. You can communicate using VoIP through your iOS device’s built in mic and speakers or stereo headphone jack.

Note: The meeting ID number is the 9-digits at the end of a link to join a meeting. If you have received a link to join a meeting (ex: https://www1.gotomeeting.com/join/123456789) do not click on the link to join the meeting. You will need to open the GoToMeeting iPad app and enter 123456789 as the meeting ID.

Attendee Viewer and Control Panel

Once attendees join a meeting they see two GoToMeeting attendee components, the GoToMeeting Viewer window (a) and the GoToMeeting Attendee Control Panel (b).
Attendee Control Panel

When attendees first join a meeting, the Attendee Control Panel appears on the right side of their desktops. The Attendee Control Panel gives attendees access to various meeting functions and is comprised of four panes: the Attendee List Pane, the Audio Pane, the Chat Pane, and Grab Tab.

After approximately 10 seconds the Attendee Control Panel automatically collapses to the right side of the screen with only the Grab Tab displayed. The auto-collapse feature can be disabled from the View drop-down menu.

The option to disable the auto-hide feature on the Control Panel is only available to attendees using PCs.

- **Attendee List Pane** - If enabled by the organizer, provides a list of all meeting attendees. (a)
- **Grab Tab** - Enables attendees to minimize the Control Panel to the side of their desktops and still access Viewer tools. (b)
- **Audio Pane** - If the organizer has given attendees a choice in how to join the audio portion of the meeting, you can switch between using Mic & Speakers (VoIP) or Telephone. (c)
- **Webcam Pane** - If enabled by the organizer, up to 6 participants can share their own webcam (d).
- **Chat Pane** - If enabled by the organizer, allows attendees to chat with other attendees, either individually or all at once, or with just the organizer or presenter (e)
- **Meeting Information** - Provided for quick reference. (f)
Attendee Control Panel Menu Bar - PC Users

The Attendee Control Panel menu bar provides access to various application tools not specifically related to attending a meeting. Menu options include File, View, Tools and Help.

File Menu

The File menu allows PC-based attendees to edit how their names and email addresses are displayed to other attendees, save the meeting chat logs as .rtf files, manage their preferences and exit meetings. From the Preferences menu, attendees can allow or forbid bubble messages to appear when another attendee chats or when GoToMeeting notifies them of system-related actions such as attendees joining or leaving a meeting.

View Menu

The View menu enables attendees to select how to display the Viewer window on their desktops and how the Control Panel behaves when not in use. Attendees can also save a customized layout or return to the Control Panel to the default layout.

Help Menu

The Help menu provides access to the online GoToMeeting Help file and to GoToMeeting software version information. There is also an option to leave feedback on the audio quality.
The Attendee Toolbar - Mac Users

GoToMeeting Menu

The *GoToMeeting* menu allows attendees to manage their Preferences and exit GoToMeeting.

File Menu

The *File* menu allows attendees to edit how their names and email addresses are displayed to other attendees, save the meeting chat logs as .html files and leave meetings.

View Menu

The *View* menu enables attendees to select how to display the Viewer window on their desktops.

Audio Menu

The *Audio* menu provides attendees another option for managing their audio settings. They can mute themselves, switch between telephone and VoIP (if enabled) and select their audio input and output.

Help Menu

The *Help* menu provides access to the online GoToMeeting Help file and to GoToMeeting software version information. There is also an option to leave feedback on the audio quality.
Attendee Control Panel Grab Tab

The Attendee Control Panel Grab Tab enables attendees to minimize the Control Panel to the side of their desktops and change the way the presenter's desktop is displayed in the Viewer window. The Grab Tab changes depending on the status of the Viewer window.

- Click and drag to move Grab Tab up or down (a)
- Click to hide or display Control Panel (b)
- Click to mute or unmute yourself (c)
- Click the Webcam button to start or stop displaying your webcam (d)
- Click the View button to change display modes (e)
- Click and drag to move Grab Tab up or down (f)
Attendee Drawing Tools

Drawing Tools must be enabled by the presenter before they appear to attendees. The presenter is the only one who can erase drawings. Drawing will pause when the presenter pauses the presentation.

To use a Drawing Tool

1. Click the Select Drawing Tool button on the Attendee Grab Tab.
2. Select the desired tool from the Drawing Tools drop-down menu.

Note: Once the drawing feature is selected, you can right-click anywhere on the Viewer window to change the drawing tool or return to non-drawing mode.

Note: The pen color can be changed from the Drawing Tools drop-down menu.

To disable a drawing tool

1. Click the Select Drawing Tool button on the Attendee Grab Tab.
2. Select Normal non-drawing mode.

Or

1. Right-click/Control-click anywhere on the Viewer window.
2. Select Normal non-drawing mode from the Drawing Tools drop-down menu.

Or

Press the Esc key to disable a drawing tool without going to the Grab Tab or Control Panel.
Chat with Other Attendees

If enabled by the organizer, attendees can chat with other attendees by using the built-in Chat feature in the Chat Pane. Or, attendees can just chat with the organizer or presenter.

- The chat log displays the text of all public chat and chat between two attendees. (a)
- The Message Entry field enables input of chat text. (b)
- The Send Chat to: field enables selection of chat recipients. (c)
- The Send button transmits chat to selected recipient(s). (d)

To chat with attendees
1. Select the desired recipient(s) from the Send Chat to: drop-down selection field.
2. Enter desired chat message in the Message Entry field.
3. Click the Send button.

To reply to a chat message
1. Select the desired recipient(s) from the Send Chat To: drop-down selection field.
   - or -
   Click the attendee's name within the Message Entry field.
2. Enter desired chat message in the Message Entry field.
3. Click the Send button.

To save a chat log
1. Under the File menu, select Save Chat Log.
2. This opens the Save Chat Log to a File window that allows you to store the file locally. Then browse to the location where you would like to save it.

To auto-save chat logs
1. Click the General category on the GoToMeeting Preferences window and select Chat Logs.
2. In the Save in: box, click Browse and select the desired directory.
3. Click OK.
Attendee Viewer Window

The Viewer window is where the image of the presenter's desktop is displayed to attendees. The Viewer window can be displayed in either a Window Mode or a Full-Screen Mode.

In Window Mode, the presenter's desktop is contained within a scaleable window.

Full Screen Mode expands the presenter's desktop completely over your own. The Attendee Control Panel/Grab Tab remains accessible.

To change the Viewer window mode

- Click the Window Mode button from the Grab Tab.

Or

- Select Window or Full Screen from the View menu on the Control Panel.
**Share Presenter Mouse and Keyboard**

At any time during a meeting, presenters may **share control of their keyboard and mouse** with any other attendee. This enables the designated attendee to share control of applications on the desktop being displayed.

When an attendee is given shared control, the GoToMeeting application notifies all attendees of the change in control by providing a System Bubble Message.

*Note:* Even though an attendee may gain shared keyboard and mouse control of the presenter's desktop, the presenter always retains overriding control by simply moving his or her mouse.
**Become a Presenter**

At any time during a meeting the presenter may pass the presenter role to any other attendee allowing the designated attendee to share the presenter's desktop screen.

When an attendee is made a presenter the GoToMeeting application shows a dialog box notifying the attendee that he or she has been made presenter and updates his or her Control Panel and Grab Tab with Presenter Tools.

The new PC-based presenter can click **Show My Screen** to present his or her entire desktop (a) or click the down arrow to select a specific application window (b). For more information about being a presenter, please see the Organizer/Presenter Control Panel section.

Mac attendees can share their entire desktop but not a specific application.

---

**Become an Organizer**

At any time during a meeting, the organizer may promote any attendee to the role of co-organizer to enable that attendee to share meeting management functions.

When an attendee is promoted to the role of co-organizer, the GoToMeeting application notifies the attendee of the change by providing a System Bubble Message and updates his or her Control Panel and Grab Tab with Organizer Tools.

For more information about being an organizer, please see the Organizer/Presenter Control Panel section.

---

© 2011 Citrix Online, LLC. All rights reserved.
Leave a Meeting

An attendee may leave a meeting at any time.

To leave a meeting

1. From the File menu on the Attendee Control Panel, select Exit - Leave Meeting.
2. Click Yes on the Leave Meeting? window.

On the GoToMeeting menu bar, select GoToMeeting and then Quit GoToMeeting; or, select File and then Leave Meeting. You may also click the red X in the top-left corner of the Control Panel and Viewer window.
The GoToMeeting Organizer Web Site

View your account information, scheduled meetings and meeting history by logging into the GoToMeeting website. Learn how to schedule an upcoming meeting from the Schedule Meetings section.

Log In to Your Organizer Website

To access the organizer website features, organizers must first log in.

To log in to your organizer website

2. Enter your email address and password and click Log In.

My Account

The My Account page enables organizers to view and edit their personal account information, change passwords, set conference call preferences and view billing information and account history.

To edit account information

2. In the left navigation bar, select My Account.
3. At the top of the My Account section, enter your current password, make any desired account or password changes and click the Save Changes button at the bottom of the page.
Change Account Password

For improved security you may want to occasionally change your account password. If your account has a company administrator, he or she may require you to change your account password on a regular basis.

To change your account password

1. Log in to www.gotomeeting.com and select My Account in the left-navigation menu.
2. Enter and confirm your new password.
3. Enter your original password.
4. Click the Save Changes button at the bottom of the page.

Note: Your new password must contain at least 8 characters and include both letters and numbers.
Audio Settings

The Audio Settings section of the organizer Web site allows you to set your default audio preferences. Choose between Voice over Internet Protocol (VoIP), long distance and/or toll-free. If you select more than one option, your attendees have the choice of dialing in with a provided conference call number or connecting with VoIP. For international attendees, set your default countries by selecting the Edit option. Alternatively, you can provide your own conference call number(s) in this section or bypass the audio option all together.

Your can override your default audio settings while scheduling a meeting or during a meeting from the Presenter's Control Panel.

Note: You may add toll-free numbers if your account includes the optional integrated toll-free audio service.

Related Topics

▶ To set audio conference options

2. Select My Meetings > Settings from the left-navigation bar.
3. Select the default audio service(s) you wish to include with your meetings. To provide local toll numbers for multiple countries, select the Edit option.
4. Click Save. Changes apply to all future meetings.

Cancel Your Account or Update Billing Information (Individual Only)

If you are an individual GoToMeeting user then you can update your credit card and billing information very easily by logging in at www.gotomeeting.com and selecting Billing Information from the expanded My Account menu in the left navigation pane.

Note: This feature only appears for individual GoToMeeting organizers and does not apply to GoToMeeting Corporate organizers.

▶ To edit account billing information

1. Log in and select My Account from the left navigation bar.
2. Click Billing Information from the expanded menu.
3. Make any desired credit card or billing address changes and then click Save Changes at the bottom of the page.
Renew or Cancel GoToMeeting (Individual Only)

With Subscription Options you can decide what will happen with your GoToMeeting account after the current plan expires.

To renew or cancel GoToMeeting after the current plan expires

1. Log in and select My Account from the left navigation bar.
2. Click Billing Information from the expanded menu.
3. From the Subscriptions Options section, select an option once the current plan expires.

Note: You can also contact Global Customer Support to cancel your account.

Note: Because GoToMeeting service is a pre-paid, your service will continue until the end of your current paid subscription period. At that time, your plan will be discontinued and will not renew again.

Is Updating Credit Card Information Secure?

Online credit card payments are processed on our secure server using a VeriSign SSL Certificate. This means GoToMeeting has been authenticated by the strictest industry standard and your transaction with us is encrypted.
Cancel Your GoToMeeting Account

If you are a GoToMeeting organizer on an individual plan, you can easily cancel your subscription from the My Account page by logging in at www.gotomeeting.com.

Note: GoToMeeting organizers on corporate plans (multi-user accounts) must contact their account manager or Global Customer Support to cancel their subscription.

Because the GoToMeeting service is pre-paid, changes made to your subscription plan (including cancellations) will not take effect until the end of your current billing period.

To cancel your GoToMeeting subscription

1. Log in to www.gotomeeting.com and select My Account in the left-navigation menu.
2. Select Billing Information in the expanded menu.
3. Under the Subscription Options section, select the "No, I do not wish to subscribe to GoToMeeting at this time" option.
4. Click Save Changes.

Once your current plan or trial period ends, your plan will not be renewed and you will lose access to GoToMeeting.
To see when your plan expires

1. Log in to www.gotomeeting.com and select My Account in the left-navigation menu.

2. Select Account History in the left-navigation menu.

3. Find the most recent entry on the Account Activity list and look under the Description column to see when your plan expires.
Plan Selection (Individual Only)

The Plan Selection section enables individual GoToMeeting organizers to view and edit their GoToMeeting plan.

Note: This feature only appears for individual GoToMeeting organizers and does not apply to GoToMeeting Corporate organizers.

To purchase or change your billing plan

1. After you sign in, select My Account from the left-navigation bar.
2. Select Plan Selection from the expanded menu.
3. Select a product and choose either a monthly or annual plan and then click Review Your Plan.
4. Enter or confirm your billing information and click Buy.
View Account History (Individual Only)

If you are an individual GoToMeeting user you can review your account activity and print receipts by logging into your account at and selecting Account History from the expanded My Account menu.

**Note:** This feature only appears for individual GoToMeeting organizers and does not apply to GoToMeeting Corporate organizers. Corporate customers should contact their account manager for account and billing related questions.

▲ To view your account billing information

1. In the left-navigation bar, click the My Account link.
2. Click Account History from the expanded menu. All billing activity since account creation is displayed.

<table>
<thead>
<tr>
<th>Date</th>
<th>Description</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>Jan 28, 2010</td>
<td>Plan Purchased Print Receipt GoToMeeting Monthly Plan extends through Feb 28, 2010 PST</td>
<td>$49.00</td>
</tr>
<tr>
<td></td>
<td>PAYMENT: Visa XXXX-XXXX-XXXX-1111</td>
<td>($49.00)</td>
</tr>
</tbody>
</table>
My Meetings

The My Meetings section enables organizers to manage their scheduled meetings and review their meeting history. See Scheduling Meetings for information on creating new meetings.

View Scheduled Meetings Online

Your scheduled meetings are first displayed when you log in to your organizer website. Scheduled meetings can also be viewed by selecting My Meetings in the left-navigation bar. Meetings can be started or ended from this page and meetings currently in session can be joined. This is the same list of scheduled meetings that can be accessed from the GoToMeeting application on your desktop.

To view scheduled meetings

2. The My Meetings page is displayed with a list of your scheduled meetings along with meetings that are currently in session. The meeting subject, start date and time are displayed.

<table>
<thead>
<tr>
<th>Subject</th>
<th>Date</th>
<th>Time</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Weekly Status</td>
<td>Recurring</td>
<td>In Session</td>
<td>End</td>
</tr>
<tr>
<td>Sales Demo</td>
<td>May 28, 2008</td>
<td>3:00 PM</td>
<td>Start Meeting</td>
</tr>
<tr>
<td>Team Meeting</td>
<td>Jun 18, 2008</td>
<td>10:00 AM</td>
<td>Start Meeting</td>
</tr>
</tbody>
</table>
**View Meeting History**

View a report of your completed meetings with the Meeting History section of the organizer website. Details include, meeting subject, date/time, duration and number of attendees. The attendee names, email addresses and join/leave times can also be reviewed.

**Note:** GoToMeeting Corporate organizers can view up to 12 months of meeting data. Individual GoToMeeting organizers can view 90 days worth.

**To view meeting history**

1. Log in to [www.gotomeeting.com](http://www.gotomeeting.com) and select *My Meetings* and then *Meeting History* from the left navigation bar.
2. Select the time frame and click the *Show History* button.
3. Click the number in the attendee column to display attendee names, email addresses and join/leave times.

<table>
<thead>
<tr>
<th>Subject</th>
<th>Date/Time</th>
<th>Duration</th>
<th>Attendees</th>
</tr>
</thead>
<tbody>
<tr>
<td>Meet Now</td>
<td>Jun 10, 2008 9:01 AM</td>
<td>166 min</td>
<td>2</td>
</tr>
<tr>
<td>Weekly Status</td>
<td>Jun 5, 2008 1:53 PM</td>
<td>586 min</td>
<td>2</td>
</tr>
<tr>
<td>Meet Now</td>
<td>May 29, 2008 2:19 PM</td>
<td>329 min</td>
<td>3</td>
</tr>
<tr>
<td>Meet Now</td>
<td>May 29, 2008 10:34 AM</td>
<td>59 min</td>
<td>3</td>
</tr>
</tbody>
</table>
Tips for Success

Prior to Meeting or Event Start

- If you plan to share your entire desktop, turn off any instant-messaging applications, notification software or other programs that may interrupt or distract from the meeting.
- Turn off any streaming media applications that may take up bandwidth and resource-intensive applications that may be taxing processor ability.
- Set the desktop display to a neutral background and adjust display settings to a mid-range resolution (e.g., 1024 x 768) to improve the display for attendees with lesser settings. This is also the optimal setting for recording a meeting.
- Clean up your desktop before a meeting. Eliminate wallpaper and icons that may distract your attendees.
- Have the documents you wish to share ready to be accessed in one or two clicks.
- Run a trial meeting with a friend to anticipate questions and to familiarize yourself with the format of your online presentation.

Managing the Meeting

- Arrive a few minutes early to greet the attendees as they arrive and start the meeting on time. It also helps to have a welcome presentation running during this time. Your presence in these opening minutes can help establish the tone and direction of the meeting.
- Create a welcome message under the Meetings category of Preferences to greet your attendees as they arrive at the meeting.
- Provide an agenda at the start of the meeting, including estimated duration, and stick to it.
- Inform attendees what the purpose/goal of the meeting is, what to expect and when and how to ask questions and participate in the meeting.
- Provide information on how to use equipment or services and how to get assistance if needed.
- Nominate a co-organizer to monitor and respond to the chat log when someone is presenting.
- Encourage participation by using open questions such as "What would you suggest?" and "How do you feel about?"
- End the meeting clearly. Make sure all the attendees know that the meeting is formally over and stay on the line to address any last questions.

Managing the Conference Call

- Call in to the meeting from a location where there is little background noise.
- Consider globally muting participants at the start of the meeting to avoid noise issues. Turn off system prompts and sounds for when attendees join or leave a meeting. Read the Voice Conferencing section of the help files to familiarize yourself with the conference call features.
- Avoid using cellular and cordless phones because of static and use the phone handset or a headset instead of speakerphones because of background noise, tunnel effect and sentence clipping.
- Turn off your call waiting. The beep of a new call on another line is heard by everyone on the teleconference.
- Avoid putting your phone on hold during a teleconference. Your hold music will play into the conference call, and make it impossible for the other attendees to continue the meeting.
- Introduce yourself when you begin speaking and ask other attendees to also identify themselves before speaking. Not everyone in the meeting may know everyone else's voice.
- If you find you are having a sound quality issue, hang up and dial back in. Sometimes these problems clear themselves up when the bad connection is terminated.
Using GoToMeeting with a Firewall

Firewalls are a popular and effective security option that are designed to block unauthorized outgoing and incoming communications with your computer. Some firewalls require additional steps to authorize trusted applications like GoToMeeting. If you have a firewall and are experiencing connection difficulties, you may have to configure your firewall.

**Note:** The GoToMeeting components need to be admitted through three ports: 80, 443 and 8200. One-way TCP connectivity is needed (TCP outbound). Visit our IP Range Fact Sheet for more information.

Configure your Firewall

Setting up a firewall to enable GoToMeeting to work requires that you take a little extra time to configure your software to allow GoToMeeting to run without interruption. Setting up GoToMeeting to work with a firewall involves two steps.

▶ To set up a firewall to allow GoToMeeting

1. Enable GoToMeeting to access the Internet.
2. The first time you host a GoToMeeting from a firewall protected PC, you will set off the firewall and be prompted to allow GoToMeeting to access the Internet.
   a. Select the check box to *Remember the answer each time I use this program.*
   b. Click **Yes** to enable GoToMeeting to access the Internet.
3. Configure your firewall to accept all GoToMeeting files.
   a. Open your firewall console.
   b. Manually select the option to allow each of the components listed above. After doing this once, you should not need to repeat this process again.

See Locating GoToMeeting Files for additional help.

▶ Using GoToMeeting within a corporate environment

If you do not have a personal firewall but are in a corporate environment, you may have a hardware firewall. Please provide the document found at www.citrixonline.com/iprange to your IT department so that they may allow GoToMeeting to connect.

If a connection still cannot be established, please contact Global Customer Support.

If your firewall does not automatically ask to allow GoToMeeting to access the Internet, you may have to enable it manually. See the following for specific help with some popular firewall software.

- McAfee firewalls
- Norton firewalls
- Kaspersky firewalls
- Other Vendors
Locating GoToMeeting Files

If you experience connection difficulties then you may need to configure your firewall to accept the GoToMeeting components.

32-bit or 64-bit Windows PCs

To locate GoToMeeting files on a PC

Note: Most versions of Windows are 32-bit, including newer models like Windows 7 and Vista.

1. Open your firewall and locate the permission settings feature.
2. Navigate to the GoToMeeting files and set permissions to accept all the GoToMeeting components.
   a. Open My Computer
   b. Click (C:) Local Disk
   c. Click Program Files (for 32-bit Windows PCs) or Program Files (x86) for 64-bit PCs.
   d. Click Citrix
   e. Click GoToMeeting
   f. Click the highest number (in this case 457), which indicates the newest build.

Enabling GoToMeeting with McAfee® Anti-virus Software

If your computer is protected by McAfee and you are experiencing connection issues then your firewall may be preventing a connection. To safely configure your firewall please locate your version of McAfee below and follow the instructions. If after following these instructions you still have Firewall related issues then McAfee Support may be able to provide assistance.
McAfee Total Protection

To configure McAfee Total Protection with GoToMeeting

1. Right-click the McAfee Total Protection icon in your system tray (usually the bottom right of your screen.)

2. Click Open McAfee Total Protection.
3. Click Firewall. (a)
4. Click Settings. (b)

5. Scroll down until you see GoToMeeting (c), select it, and then click Edit. (d)
6. Set Access to Full. (e)

7. Click Save. (f)

8. If you cannot find GoToMeeting in the list of programs, click Add and navigate to the files.
Enabling GoToMeeting with Norton® Anti-virus Software

If your computer is protected by Norton and you are experiencing connection issues then your firewall may be preventing a connection. To safely configure your firewall please locate your version of Norton and follow the instructions. If after following these instructions you still have Firewall related issues then Norton Support may be able to provide assistance.

Norton Internet Security 2010

To configure Norton Internet Security 2010 for GoToMeeting

1. Open the Norton Internet Security console. Click the Settings (a) button on the Network tab.

2. Scroll down to Smart Firewall, then click Configure (b) next to Program Settings.
3. Find GoToMeeting, select Allow (c) from the dropdown menu, and click Apply. (d)

4. If you cannot find GoToMeeting in the list of programs, click Add and navigate to the files.

Norton 360 3.0

To configure Norton 360 3.0 for GoToMeeting

1. Open the Norton 360 3.0 console.
2. Click the PC Security tab.
3. Click Manage Firewall. (a)
4. Scroll down to GoToMeeting, select **Allow** (b) from the drop-down menu, and click **Apply**. (c)

5. If you cannot find GoToMyPC in the list of programs, click **Add** and navigate to the files.
**Enabling GoToMeeting with Kaspersky® Anti-virus Software**

If your computer is protected by Kaspersky and you are experiencing connection issues then your firewall may be preventing a connection. To safely configure your firewall please locate your version of Kaspersky and follow the instructions. If after following these instructions you still have Firewall related issues then [Kaspersky Support](#) may be able to provide assistance.

**Kaspersky Anti-Virus 2010**

▶ **To configure Kaspersky for GoToMeeting**

2. Click **Settings** in the top right.
3. Under **Options**, select **Threats and exclusions**. (a)
4. Under **Exclusions**, click **Settings**. (b)
5. Click the **Trusted applications** tab.
6. Click **Add** and browse to the [GoToMeeting program folder](#).
7. Check all of the boxes for exclusions (c) and click **OK**. (d)
8. Click **OK** again, then click **Apply**. (e)
Additional Firewall Resources

If you have specific vendor related firewall questions that were not covered in our firewall section then please contact your provider.

AVG

Contact (support requires payment)

Configuration information

Avira Firewall

Contact

Configuration information

Bit Defender

Contact (requires an account)

Configuration information

Note: Please refer to pages 222-226 of BitDefender Internet Security on configuring the firewall.

ESET

Contact

Configuration information

Trend Micro

Contact (800-864-6027)

Configuration information

Note: Although the instructions refer to an email program, they guide you to the program permissions where you can adjust the settings for GoToMeeting.

VIPRE

Contact (877-673-1153)

Configuration information

Webroot

Contact

Configuration information

Zone Alarm

Contact

Configuration information

Note: Click Knowledge Base, then search "How do I change settings for individual programs in ZoneAlarm?"
Troubleshooting and FAQs

General GoToMeeting FAQs

I never received my meeting organizer invitation email. What should I do?

It's possible that your email server blocked the invitation email. If you do not have the ability to check email in a spam folder, check with your Administrator to see if the invitation can be resent. Otherwise, ask your administrator to contact the GoToMeeting account manager for help.

How can I view scheduled meetings?

To see what meetings you have scheduled, right-click the icon in the system tray or double-click the GoToMeeting Suite icon on a Mac and select My Meetings. After your login email address is verified, you will see the list of scheduled meetings.

You can also log in to www.gotomeeting.com and view your scheduled meetings.

I forgot my password. What should I do?

First, make sure you are entering your correct login email address and password. Note that your password is case sensitive and must contain at least 8 characters and include numbers and letters.

If you still need to reset your password, just visit https://www.gotomeeting.com/en_US/forgotpassword/forgotPassword.tmpl and enter your email address. You can also reach this page via the www.gotomeeting.com login page. An email will automatically be sent to your login email address to reset your password.

How long will my past meetings appear in my Meeting History?

Past meetings will appear in your Meeting History for 90 days, after which they will be deleted from the system. If you would like to keep records of your meetings for auditing purposes, have your administrator run a Meeting History report at least once every 90 days and then save it locally.

Why does the meeting pause when I open a window that I am not sharing?

The application-sharing feature is set up to ensure that you are only sharing the specific window that you have selected. If you inadvertently open a different window, GoToMeeting will automatically pause the meeting to protect your privacy. Screen sharing will resume once you have moved or closed the obstructing window. The Specific Application Sharing feature is only available to PC users.

What happens when I stop showing my screen? What do my attendees see?

When you click the Stop button, screen sharing will be turned off and you will no longer transmit your desktop contents to your attendees. Instead, your attendees will see the Waiting Room screen until you click the Play button to resume screen sharing. Upon request, GoToMeeting Corporate users can display their company logo on the Waiting Room screen.
How do I share one application and nothing else?

A presenter can share a single application by right-clicking the screen-sharing icon on the Control Panel Grab Tab and then selecting the application to share from the list of applications presented. The application-sharing feature is only available to PC users.

After I've given keyboard and mouse control away, how do I get it back?

As a security feature, you can regain control of your desktop/laptop by simply moving your mouse. The change of control happens almost instantaneously. At any time, you can revoke an attendee's shared control of your mouse and keyboard if you want to prevent him or her from regaining control.

Are there any files or folders left on an attendee's computer after the session ends?

Some downloaded files do remain after a meeting so that the attendee may join future meetings more quickly (without having to download all the files again). However, the files are inactive, will not consume system resources, do not compromise security and perform no functions until the attendee joins another meeting and the files are engaged by a new meeting ID. If desired, an attendee may uninstall all GoToMeeting files using the Add/Remove Programs feature in the Windows control panel.

Why would I make someone else an organizer in my meeting?

If you created a meeting and needed to leave, but wanted your attendees to continue the discussion, you would want to make someone else the organizer. The meeting would proceed without you without interruption. Or, you could appoint a co-organizer to monitor and respond to attendee chat questions while you focused on the task of presenting.

Is there a charge for using the integrated conference call service or VoIP?

GoToMeeting is packaged with both VoIP and a phone conferencing service at no extra cost to you. You may decide to use one or both of these services or choose another method of bringing audio to your online meetings. Our phone conference service provides a toll-based number that is dialed by all meeting participants. Participants are then charged their standard long-distance rate for calling this toll-based number, just as if they made a regular long-distance call. There is no additional charge for the conferencing feature. If attendees wish to avoid incurring long-distance charges, then they can join the meeting with VoIP. Please see Integrated Toll-Free Audio for information on how to provide your attendees a toll-free option.

How do I save chat sessions from my meetings?

Under the File menu, select Save Chat Log. This opens the Save Chat Log to a file window that allows you to store the chat log locally. Or, if you are using a PC, under the General category of your GoToMeeting Preferences, you can check the box marked Chat Logs to automatically save your chat logs to your local computer after each meeting.

Where can I find instructions for the integrated conference call service?

Conference call information for organizers is available in the GoToMeeting Integrated Audio section.
Is training available for GoToMeeting?
Yes, please see the Product Training section of this site for more information.

Is there an attendee? How can I view information about past attendees?
Log in to www.gotomeeting.com with your email address and password. Select My Meetings from the menu options on the left. Select Meeting History from the sub-menu options.

Are Mac or Linux operating systems supported with GoToMeeting?
Currently Linux operating systems are not supported by GoToMeeting, either to host or join a meeting. However, GoToMeeting does support Mac-based organizers and attendees with somewhat limited functionality.

Is audio streaming supported in GoToMeeting?
Yes, online audio, or VoIP, is an alternative to dialing in with a conference phone number. However, the organizer cannot stream sound files from his computer onto attendees’ speakers.

Is video streaming supported in GoToMeeting?
While we do not yet support streaming video, our GoToMeeting technology is fast enough to keep up with screen changes on the desktop, so it appears as if it is streaming video.

Because more data is being sent to all meeting attendees, bandwidth usage will go up for all meeting participants. The amount will depend on the resolution and length of the video.

Also, certain versions of Windows Media Player with Microsoft DirectX (an advanced suite of multimedia application programming interfaces, or APIs, built into Microsoft Windows operating systems), will not display the video.

To enable video display for your meetings, you need to disable Hardware Overlay for your player. Please see your media player’s help section for instructions on disabling Hardware Overlay.

a. A workaround exists through Skype, which in some cases can allow for video conferencing simultaneous to an instance of GoToMeeting. However, Skype uses a significant amount of bandwidth, which can affect quality.

Why am I having trouble sharing specific applications during a meeting?
If you are using a multi-monitor enhancement application like UltraMon™ or ObjectDock™ software that adds a button to each window you may experience difficulties sharing specific applications. Try disabling the window buttons in these types of applications to resolve the issue. If you are using a Mac, you will not be able to select a specific application to view.

Can attendees collaborate on a Word document in real time? Is there a file sharing tool associated with GoToMeeting?
At this time there is no file sharing tool integrated with GoToMeeting. The best way to collaborate on a document is to cede keyboard and mouse control to the user that wishes to make a change. The change will take effect on the organizer's computer, and he can later save the document.

**Does GoToMeeting integrate with non-Outlook clients?**

Unfortunately, GoToMeeting only integrates with MS Outlook and IBM Lotus Notes at this time.

**Can I change a meeting in Outlook without going into GoToMeeting to change the time manually?**

No, once you generate the invitations and calendar event you must change the meeting time in GoToMeeting if you want to reschedule the meeting.

**What happens if I have two monitors?**

You can choose to either display one or both of the monitors. However, your two-monitor display may cause problems of resolution and visibility for your attendees if you display both monitors simultaneously.
HDFaces Video Conferencing FAQs

GoToMeeting with HDFaces, a high-resolution video conferencing technology, enables participants to share and view up to 6 high-resolution video conferencing streams in session while viewing the presenter's screen.

Related Topics

How is HDFaces different from other web conferencing video solutions?

We provide the highest resolution video conferencing quality currently available among web conferencing providers—up to 6 streams at 640p x 480p for a maximum resolution of 1920p x 960p. We combined the video conferencing and screen sharing Viewer into 1 window so participants can collaborate on shared content and see each other at the same time for a highly effective, engaging user experience. With 1-on-1 video conferencing, up to 1280 x 720p is supported (depending on your webcam, lighting, network and computer).

How much does HDFaces cost?

HDFaces is included with GoToMeeting at no additional cost.

Does GoToMeeting HDFaces work on Macs?

Yes, Mac and PC features are nearly identical.

What are the system requirements for GoToMeeting HDFaces?

- Internet connection with cable modem, DSL or better.
- Windows® 7, Vista, XP or 2003 Server, or Mac OS® X 10.5 Leopard® or later.
  
  Note: From our preliminary testing, Mac OS X 10.7 Lion® appears to work fine with HDFaces. Mac OS X 10.7 Lion® will be formally tested and officially supported in an upcoming release.

  - Dual core 1.6GHz CPU or faster with at least 2 GB of RAM.
  - Internet Explorer® 7.0 or later, Mozilla® Firefox® 3.0 or later, Google Chrome 5.0 or later or Safari® 3.0 or later (JavaScript and Java enabled).
  - 700 Kbps or more bandwidth recommended per participant for simultaneous screen sharing, audio and video conferencing.

Which webcams are recommended?

Video conferencing will work with most standard video conferencing webcams. From our testing, we highly recommend the following webcams:

- Logitech® HD Pro Webcam C910
- Logitech HD Webcam C510
- Logitech HD Webcam C310

Which webcams are unsupported?

GoToMeeting with HDFaces does not support the following webcams:

- 4eyeGrab
- Hava Remote Video Device
- Hava Video Device
- BT878 VfW to WDM mapper (32-bit)
- Live! Cam Notebook Pro (VF0400)

How many video streams can we share with GoToMeeting with HDFaces?
You can share up to 6 streams at a resolution of 640p x 480p each, for a total maximum resolution of 1920p x 960p.

If 6 video streams are being shared and I turn off my video stream, can another participant share their video?

Yes, participants can stop and share video streams at any time. Organizers can also disable an attendee’s video stream so that another participant can share their webcam.

Can I temporarily stop my webcam without giving up my webcam slot?

Yes. You can pause your webcam temporarily by clicking the Pause button on the top-right corner of your webcam feed.

Can international customers use GoToMeeting with HDFaces?

Yes, international customers can use HDFaces.

Is HDFaces available on GoToWebinar and GoToTraining?

Not yet. It's currently only available for GoToMeeting and is planned for GoToWebinar and GoToTraining in future releases.

If I'm participating in the GoToMeeting Web Viewer Beta, can I also participate in GoToMeeting with HDFaces?

No. If you want to upgrade to GoToMeeting with HDFaces, you'll lose access to Web Viewer functionality. If you want to return to the Web Viewer Beta after upgrading to HDFaces, you can opt in again via http://www.gotomeeting.com/webviewer/beta, or by calling Global Customer Support.

Are attendees required to install HDFaces prior to attending a meeting?

No. As with all versions of GoToMeeting, attendees download the organizer's version of GoToMeeting without affecting their own version.

How do I set up my webcam to use with GoToMeeting with HDFaces?

Install your webcam using the manufacturer's installation instructions. You can set your webcam settings from the GoToMeeting Preferences window. We recommend that you use a headset with mic and speakers (VoIP) instead of your webcam's built-in webcam mic and speakers.

What happens if I install a webcam during an HDFaces session?

In most cases, GoToMeeting should be able to detect your new hardware and allow you to use it during the same session.

What are the bandwidth requirements for HDFaces?

We recommend 700Kbps or more per participant for simultaneous screen sharing, audio and video conferencing. HDFaces uses bandwidth optimization to make the best possible use of any available bandwidth. If you experience slow performance issues, try closing data-intense applications like YouTube, Netflix, Skype, etc.

What is the supported video frame rate?

HDFaces supports up to 30-frames per second. The frame rate depends on your webcam, lighting, network and computer.

What kind of security does HDFaces provide?
HDFaces includes the same excellent security and encryption of GoToMeeting, including end-to-end Secure Sockets Layer (SSL) and 128-bit Advanced Encryption Standard (AES) encryption.

**How many video conferencing webcams can be shared with GoToMeeting with HDFaces?**

HDFaces supports sharing up to 6 video conferencing webcams at once. Attendees can join HDFaces meetings even if they don't have webcams. Up to 26 attendees will be able to see video conferencing webcams.

**Can I join a GoToMeeting with HDFaces session from an iPad, iPhone or iPod Touch?**

Yes. You can join HDFaces meetings as an attendee, but you'll be unable to view or share webcams and show your screen (if you're given presenter controls) at this time.

**Can I join a GoToMeeting with HDFaces session from an Android smartphone?**

Yes. You can join HDFaces meetings as an attendee, but you'll be unable to view or share webcams and show your screen (if you're given presenter controls) at this time. Please see the Android FAQs for a list of supported devices.

**Can I hide webcams?**

Yes. Click the **Webcams** drop-down menu and select **Hide Webcams**. Even though you've hidden webcams, other participants can still see your webcam broadcasting. To bring webcams back to view, select **Show Webcams**. You can also click and drag the divider between the webcam feeds and screen-sharing viewer to resize or hide webcams.

**Can I position webcams so they always remain on top of all my other applications?**

Yes. On the top-left of the webcam viewer, click the **Webcams** drop-down menu and select **Always in Front**.

**Can I adjust the positioning and display of my webcams?**

Yes. You can click and drag the bottom-right corner of the viewer to expand and minimize how the webcams and/or screen sharing is displayed. If the organizer is not screen sharing, you can adjust the size and position of the webcam viewer by using the **Webcam** drop-down menu and selecting one of the following Webcam Positions: **Top, Left, Bottom, Right**.

**What are some video conferencing tips and best practices?**

- Secure your webcam on your computer to make sure it's stable and won't move around.
- Choose a location with adequate lighting. If you're sitting directly in front of a window, try moving to another spot; otherwise, your webcam may only capture your silhouette.
- Position your webcam so that your entire face fills up at least half of your webcam viewer.
- For optimal performance, open the GoToMeeting **Preferences** window, select **Webcam** and then click **Advanced**. If you have a high-performance webcam, you can enable high-quality features, such as "face recognition" or "right light," to enhance your video conferencing experience.

**How do I select a different webcam if I have more than one plugged in to my computer?**

To select a different webcam, open the **Preferences** window and select **Webcam**. If more than one webcam is detected, simply choose which webcam you'd like to use from the **Your Camera** section.

**Can I record webcams during an HDFaces session?**

Although you can record screen sharing and audio, you cannot record webcams at this time.
HDFaces Video Conferencing Troubleshooting FAQs

Why can't I see other meeting participants' webcams?
Your webcam viewer may be minimized, but you can bring the viewer back up again from your taskbar or dock. If the organizer has unchecked the Attendees Can Share Webcams option, you will not be able to share your webcam. If you previously selected the Hide Webcams option from the Webcams drop-down menu, then select Show Webcams.

Why can't other attendees see my webcam?
Double check to see if your webcam is connected to your computer, and then try clicking the Share My Webcam button if you haven't already done so. To see if your webcam has been detected, open Preferences and select Webcam.

What should I do if I'm experiencing poor video quality?
Make sure you have adequate lighting in your room. If you have low bandwidth, you should make sure you have nothing else running that might use up bandwidth. If your webcam is out of focus, turn off the auto-focus setting on your webcam. You can also check to see if you're using one of our unsupported webcams.

What should I do if my webcam stops working?
If you have low bandwidth or CPU issues, you may see a "Low Bandwidth" or "Computer Overloaded" message. You'll be prompted to hide all webcams and/or stop sharing your own webcam. If you click Yes, all webcams and/or your own webcam will be hidden.

To improve bandwidth and CPU performance, close all other programs on your computer, and switch to a high-speed cable Internet connection (if you haven't already).

Why is the Share My Webcam button disabled (grayed out)?
The organizer may have disabled the Attendees Can Share Webcams setting or the maximum webcam limit may have been reached (only 6 webcams can be shared at once).

If you're an organizer and cannot share your webcam, open Preferences and select Webcam to make sure that your webcam has been detected. You may need to leave and restart the session.

After I clicked the Share My Webcam button, why do I see a "Connecting" message that won't go away?
The video conference may be down or unavailable. If you're an organizer, try restarting the meeting. If you're an attendee, try leaving the meeting and then rejoining.

What happens if I'm sharing my webcam and start experiencing connectivity issues?
If you're sharing your webcam and your network connection momentarily goes down for a few seconds, your webcam will automatically start back up again. If your connection is down for more than 1 minute, you will need to re-click the Share My Webcam button to restart video conferencing once your network becomes available again.
Troubleshooting GoToMeeting with a Firewall

If you are experiencing issues when connecting to your meeting it may be due to an Internet security application such as a firewall. Ensure the following files have full access to the Internet:

<table>
<thead>
<tr>
<th>GoToMeeting Components</th>
</tr>
</thead>
<tbody>
<tr>
<td>g2m_download.exe</td>
</tr>
<tr>
<td>AppCore.exe</td>
</tr>
<tr>
<td>G2MInstallerExtractor.exe</td>
</tr>
<tr>
<td>G2MCodecInstExtractor.exe</td>
</tr>
<tr>
<td>G2MInstHigh.exe</td>
</tr>
<tr>
<td>G2MInstaller.exe</td>
</tr>
<tr>
<td>G2MUinstall.exe</td>
</tr>
<tr>
<td>G2MComm.exe</td>
</tr>
</tbody>
</table>

These GoToMeeting components need to be admitted through three ports: 80, 443 and 8200. One-way TCP connectivity is needed (TCP outbound). Should you need to authorize specific IP ranges, our IP ranges can be found here: www.citrixonline.com/iprange.

Using GoToMeeting with a Firewall

Setting up a firewall to enable GoToMeeting to work requires that you take a little extra time to configure your software to allow GoToMeeting to run without interruption. Setting up GoToMeeting to work with a firewall involves two steps.

To set up a firewall to allow GoToMeeting

1. Enable GoToMeeting to access the Internet.
   - The first time you host a GoToMeeting from a firewall protected PC, you will set off the firewall and be prompted to allow GoToMeeting to access the Internet.
     a. Select the check box to Remember the answer each time I use this program.
     b. Click Yes to enable GoToMeeting to access the Internet.

2. Configure your firewall to accept all GoToMeeting files.
   a. Open your firewall console.
   b. Manually select the option to allow each of the components listed above. After doing this once, you should not need to repeat this process again.

Using GoToMeeting within a corporate environment

If you do not have a personal firewall but are in a corporate environment, you may have a hardware firewall. Please provide the document found at www.citrixonline.com/iprange to your IT department so that they may allow GoToMeeting/GoToWebinar to connect.

If a connection still cannot be established, please contact Global Customer Support.

Using GoToMeeting with Norton Internet Security Firewall

To set up a Norton firewall to allow GoToMeeting

1. Right-click on the Norton Internet Security icon on your host computer's system tray (bottom-right of your desktop).
2. Select Open Norton Internet Security from the system tray menu.
3. Select Personal Firewall from the Status & Settings menu and click the **Configure** button.
4. Select the **Programs** tab, locate GoToMeeting and then click **Add**.
5. To begin adding files, click on g2comm.exe and click **Open**.
6. From the **Program Control** prompt select **Permit** from the drop down menu and click **OK**.
7. Repeat these two steps to add the remaining GoToMeeting files:

**Using GoToMeeting with Norton Transaction Protection**

If your version of Norton Internet Security has the Norton Transaction Protection feature enabled, you may need to adjust your Norton settings in order to use GoToMeeting.

**To set Norton Transaction Protection to allow GoToMeeting to run**

1. If you have not already done so, host a practice meeting.
2. End the session.
3. While physically present, right-click on the Norton Internet Security icon on your system tray.
4. Select **Open Norton Internet Security** from the system tray menu.
5. Click on the **Norton Internet Security** tab at the top of the Norton window.
6. From the Settings drop-down list, click the **Norton Internet Security Options** link.
7. Click the **Transaction Protection** link from the left side of the window.
8. Change the status to allow g2mlauncher.exe and then click **OK**.

**Using GoToMeeting with ZoneAlarm Firewall**

**To set up a ZoneAlarm firewall to allow GoToMeeting**

1. Double-click the ZoneAlarm icon on your host computer's system tray.
2. Select **Program Control** from the menu on the left.
3. Verify that you are viewing the **Programs** tab.
4. Click the **Add** button on the bottom-right of the screen.
5. Navigate to the GoToMeeting folder on your computer (C:\Program Files\Citrix\GoToMeeting).
6. Highlight all of the GoToMeeting files in that folder and click **Open** to add the GoToMeeting files.
7. Locate the GoToMeeting file in the Programs list, click the ? icon in the Trust Level column and select **Super**. Repeat this step for each of the GoToMeeting files.
8. Finally, click each ? icon in the Access and Server columns that correspond to a GoToMeeting program and select **Allow**.

**Program Control**

<table>
<thead>
<tr>
<th>Active</th>
<th>Programs</th>
<th>Trust Level</th>
<th>Access</th>
<th>Server</th>
<th>Send Mail</th>
</tr>
</thead>
<tbody>
<tr>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
</tr>
</tbody>
</table>

© 2011 Citrix Online, LLC. All rights reserved.
Audio FAQs

What if I can’t hear other callers?

- In the Attendee List of your Control Panel, click the audio icon to unmute an individual attendee or click Unmute All to unmute all attendees in the meeting.
- Telephone users: Hang up and dial back in.
- VoIP users:
  a. Test your speakers setup. Click Audio Setup in the Audio Pane to select the correct device. Mac users should: click the speaker icon in the Audio Pane to select the correct device.
  b. Check the volume setting in audio setup. Click Speakers Setup and then click Play Sound. Adjust the slider bar to the desired volume.

What if other callers can’t hear me?

- You can change your audio selection from the Audio Pane if you scheduled your meeting to offer both VoIP and telephone options.
- Telephone users: Hang up and dial back in.
- VoIP users:
  a. Click Audio Setup in the Audio Pane to see if the correct microphone device is selected? Mac users should: click the microphone icon in the Audio Pane to select the correct device.
  b. If using a microphone, check to see if your microphone has a physical mute/unmute button on it? If it does, make sure your microphone is not muted.
  c. If an attendee can’t hear you, his or her speaker volume may be off or set too low.
  d. Analog microphones are sometimes too quiet; we recommend using a USB headset or USB desktop microphone instead.
  e. If you are using a desktop microphone, avoid touching the microphone since it may cause a reduction in the volume of your voice.
  f. Speaking very loudly can affect the volume; try speaking at a lower level.
  g. The speed of your Internet connection can affect one-way sound. For optimum performance when using VoIP, we recommend a broadband Internet connection.
  h. File sharing: Uploading a file while using GoToMeeting can sometimes affect VoIP sound quality. It is recommended that you close all file sharing applications before you start your meeting.
  i. Streaming music or video while using GoToMeeting can sometimes affect VoIP sound quality. It is recommended that you close all streaming music or video before you start your meeting.

What if I hear static, beeping or a clicking sound?

- Electronic devices, such as Blackberries, can affect the sound quality of microphones and speakers. To avoid this, keep any electronic handheld devices away from your microphone and speakers during your meeting.

What if I experience an echo, feedback or background noise?

- A USB headset is recommended (see VoIP Audio Device Recommendations).
• If you suspect an echo is coming from an attendee, see who is speaking by looking at the bottom of the Audio Pane. Then mute that attendee or ask the attendee to lower his or her speaker volume. You can also click **Mute All** in the Audio Pane.

• If you join your meeting via telephone make sure the audio setting on your Control Panel is not set to **Use Mic & Speakers**.

• Built-in or external speakers can cause echo. We recommend reducing the speaker volume to a low level.

• Laptops with built-in microphones can pick up noise and cause echo. Using a built-in microphone for your audio is not recommended. If you know how to turn off your laptop's built-in microphone, turn it off for your presentation. (Check your laptop's owner manual.)

• Webcams with microphones can pick up additional noise and cause echo. Using a webcam for your audio is not recommended.

• A meeting is best presented from a quiet location.

• If using a microphone, move the microphone closer to your voice and away from competing sounds (e.g. computer fans).

• Avoid moving or touching the microphone during your presentation.

**What if words are clipped or dropped?**

Dropped words, delays or robotic sounds are often due to poor network performance, lack of memory or high CPU usage.

- Close all applications you are not using for your presentation.
- VoIP users: A dial-up Internet connection can cause poor performance. For optimum performance when using VoIP, we recommend a broadband Internet connection. If the problem persists, switch to Telephone mode. Select **Use Telephone** in the Audio Pane and dial in to the meeting.

**How do I adjust my VoIP audio volume?**

- Click **Audio Setup** in the Audio Pane. Under Speakers Setup, move the slider bar to the desired volume.

**What if I get an error message?**

**No Speakers Detected**

An error message will appear if speakers (or headset) are not present or are not connected properly, or if there is no sound card installed in your computer. You will not hear audio at this time and will not be heard in the conference.

- Check that your speakers (or headset) are properly connected and click **Try Again** in the Audio Pane of the Control Panel. Please refer to the VoIP Audio Setup in this section for more information.
- If you have the option to join the meeting via telephone, you will automatically be switched to Telephone mode. Dial in to the conference using the number and audio PIN provided in the Audio Pane of your Control Panel.
No Sound Detected

After the first minute of a session, GoToMeeting looks for microphone input from attendees who are using a microphone, have speaking rights and are unmuted.

If no input is detected, you may get a "Trying to speak?" error message. This error may appear under the following conditions:

- You have not spoken or made any sound during the first minute of joining the meeting.
- The microphone device was incorrectly selected. You can click the Audio Setup link if you are trying to speak but can't be heard. Please refer to See VoIP Audio Setup in this section for more information.

No Microphone Detected

- An error message will appear if a microphone (or headset) is not present or is not connected properly. You will still be able to hear the meeting but will not be able to speak.
- Check that your microphone is properly plugged in. If it is, test your microphone device and click Try Again in the Audio Pane of the Control Panel. Please refer to VoIP Audio Setup in this section.
- If you have the option to join the meeting via telephone, you can switch to Telephone mode. Then dial in to the conference using the number and audio PIN provided in the Audio Pane of your Control Panel.

Microphone Disconnected

An error message will appear if your microphone fails or is unplugged after joining a meeting. When this happens, you will no longer hear audio nor be heard by others.
• Check that your microphone is properly plugged in. If it is, test your microphone device and click Try Again in the Audio Pane of the Control Panel. See VoIP Audio Setup - PC or VoIP Audio Setup - Mac in this section.
• If you have the option to join the meeting via telephone, you can switch to Telephone mode. Then dial in to the conference using the number and Audio PIN provided in the Audio pane of your Control Panel.

How do I turn entry and exit chimes on/off?

You must be dialed in via telephone to turn entry and exit chimes on or off. In GoToMeeting, entry and exit chimes are turned on by default. Press *8 to cycle through the entry and exit chimes options.

How do I mute and unmute attendees?

• PC users: Click the microphone or handset icon (a)
• Mac users: Click an attendee's name

What does it mean when both telephone and VoIP are enabled? Why would anyone need that?

When both telephone and VoIP are enabled, your attendees have a choice to join the conference with either their phone or computer speakers/ USB headset. While attendees cannot access both audio options simultaneously, we do recommend offering your attendees a choice.

Can I use GoToMeeting for audio-only conferencing?

Yes, you can use GoToMeeting's integrated audio without actually starting the meeting on your computer. However, without the GoToMeeting control panel you and your attendees will not have access to the unique audio PIN which is needed for muting controls. If you choose to join without the audio PIN, then press the pound (#) key on your phone instead of the audio PIN.

Audio Tips and Best Practices?

• As with any meeting, it is important to test your sound quality and audio settings before your live event.
• If you plan to record your meeting, be sure to test the Recording feature prior to your meeting; start a Meet Now and record a few minutes to test your settings.
• Close all applications and documents you are not using for your presentation; applications running in the background may use up your computer's bandwidth and affect system performance.
• Keep attendees muted during your presentation and unmute individual attendees as necessary. Attendees are joined unmuted by default.
• If you join the conference by phone, make sure that any other phones and data devices (BlackBerry, iPhone) are either turned off or are away from your computer.
• Ensure that your mouthpiece volume is turned up so the attendees can hear you, and that your earpiece volume is turned up so you can hear the other attendees.
• If you join with VoIP, we recommend you use a USB headset rather than a microphone/speakers to improve call quality.
• For more ways to optimize your audio please visit Integrated Audio.
Mac OS X 10.7 Lion FAQs

The new Mac Lion OS promises to be a great upgrade for Mac customers. It includes over 250 new features and many usability enhancements. We have been working closely with Apple and testing our products with this new OS. There are a few known issues that our Mac customers should be aware of if they upgrade to Lions.

Does HDFaces work with Mac OS X 10.7 Lion?

From our preliminary testing, Mac OS X 10.7 Lion appears to work fine with HDFaces. Mac OS X 10.7 Lion will be formally tested and officially supported in an upcoming release.

If I purchase Mac OS X Lion, will GoToMeeting, GoToWebinar or GoToTraining work for me?

Yes, but you will need to make sure that (1) you're using GoToMeeting 4.8 or higher, and (2) you've installed a version of Java compatible with OS X Lion.

1. Checking the Version Number

   If you have GoToWebinar or GoToTraining, remember that you will only see GoToMeeting on the menu bar and desktop icon because the 3 products are all part of the same collaboration suite. To see which GoToMeeting, GoToWebinar and/or GoToTraining version you're using on your Mac, do one of the following:

   - **In session:** Click GoToMeeting in the menu bar and select About GoToMeeting. The version number will be listed in the window that pops up.
   - **Not in session:** Hover your mouse pointer over the GoToMeeting ( `% `) daisy icon in your dock to see a pop-up message listing which version you're using.

   If you are not using GoToMeeting, GoToWebinar or GoToTraining 4.8 or higher, you will still be able to host meetings but will not be able to share your screen. To upgrade to the newest version, contact your account manager (if you're on a corporate account) or call our toll-free 24/7 support line and request to be upgraded.

2. Installing Java

   GoToMeeting, GoToWebinar and GoToTraining require Java to be installed in order to host or join sessions; without it, the GoToMeeting, GoToWebinar and GoToTraining applications cannot launch. Since OS X Lion does not include Java, you will need to download and install a version of Java compatible with OS X Lion (this is a one-time download of 150 MB). See [Java is not installed in Mac Lion. Do I need it?](#) below for information on downloading Java.

Can I host a GoToMeeting, GoToWebinar or GoToTraining session from Mac OS X Lion?

Yes. As long as you're using GoToMeeting, GoToWebinar and/or GoToTraining 4.8 or higher and have Java installed, your current version will work fine. If you are using an older version, then you may be able to start the session but you will not be able to share your screen. See [If I purchase Mac OS X Lion, will GoToMeeting, GoToWebinar or GoToTraining work for me?](#) above for more information.

Can I attend a GoToMeeting, GoToWebinar or GoToTraining session from Mac OS X Lion?

Yes. As long as you have Java installed, you should have no trouble joining. However, if the organizer is not using GoToMeeting 4.8 and makes you the presenter, you will be unable to share your screen. See [If I purchase OS X Lion, will GoToMeeting, GoToWebinar or GoToTraining work for me?](#) above for more information.

Java is not installed in Mac Lion. Do I need it?
Yes. GoToMeeting, GoToWebinar and GoToTraining require Java to be installed in order to launch the application. Since OS X Lion does not include Java, you will need to download and install Java compatible with OS X Lion (this is a one-time download of 150 MB). You can do so directly from Apple's support site at [http://support.apple.com/kb/DL1421](http://support.apple.com/kb/DL1421). However, if you try to start or join a GoToMeeting, GoToWebinar or GoToTraining session before installing Java on your Mac, you can still complete the download using the following steps:

1. Try to start or join a session. A "Missing Plug-in" message will appear instead of the download progress bar on the Download page. Click on the Missing Plug-in icon (ﬁ) next to the message.

![Starting Meeting](image)

2. When the following pup-up message appears, click **Install**.

![Open Applet](image)

3. When the following License Agreement appears, click **Agree**.
4. When the following Download Progress bar appears, Java will begin automatically downloading and installing the necessary packages (150 MB).

5. After installation is complete, you will need to refresh the page or simply launch the meeting, webinar or training session again. You will then be able to join or host GoToMeeting, GoToWebinar or GoToTraining sessions from Mac OS X Lion without being asked to download Java again.

What are the known issues with using GoToMeeting, GoToWebinar and/or GoToTraining on OS X Lion?

If you do not have GoToMeeting 4.8 or higher and are using OS X Lion, then you will not be able to share your screen as an organizer or attendee (if you are made the presenter).

Contact Us

Should you have any questions about using GoToMeeting, GoToWebinar or GoToTraining with the new Mac Lion OS, please feel free to contact your account manager or call our toll-free 24/7 support line.
**Integrated Toll-Free FAQ**

**What is Integrated Toll-Free Audio Service?**

Integrated Toll-Free Audio is a service that allows you to offer your GoToMeeting, GoToWebinar and GoToTraining attendees a toll-free option. With integrated toll-free you have the flexibility to schedule your sessions with any combination of toll-based, toll-free and VoIP audio.

**How much does it cost to use the Integrated Toll-Free audio service?**

Per-minute charges are based on your service contract, and minutes are calculated per participants. (For instance, if three participants call in the session for 10 minutes using the toll-free option, you will have used 30 minutes of your plan. Those who join by regular toll numbers are charged rates based on their own long-distance provider. There are no additional charges for those who join a meeting or Webinar with VoIP audio.

**How am I billed for the toll-free service?**

You will receive a separate monthly invoice from Citrix Online Audio, LLC for any toll-free minutes used by you and your attendees.

**How do I add the toll-free option to meetings that I've already scheduled?**

For any Webinar, meeting or recurring meeting that was scheduled prior to an account's toll-free integration, the regular toll based conference numbers will automatically be changed if toll-free numbers are added to an already existing meeting or Webinar. It is recommended that you resend the meeting invitation to participants so they have access to the new toll-free audio information. Meeting IDs and URLs will stay the same, however, and the new toll-free number will be provided to attendees in the waiting room, as well as on the Control Panel.

**Will I use the same toll-free number for each meeting?**

No, as with existing meetings and Webinars, each session will have a unique toll-free number and access code. If you wish to re-use the same audio options for your meetings, select the Recurring meeting box in the Schedule a meeting window.

**How do I schedule a meeting with Integrated Toll-Free?**

To add a toll-free number to your meeting invitation, select the Edit Countries link in the Schedule a Meeting window. Next, scroll to the bottom of the list of countries and select the option for the toll-free number you would like to provide.

**Do you offer toll-free numbers for countries outside of the United States and Canada?**

Yes, integrated toll-free is available from the following countries. However, in order to use integrated toll-free the organizer must be in the United States, Canada, the United Kingdom, or Australia.

<table>
<thead>
<tr>
<th>International Toll-Free Conference Numbers</th>
</tr>
</thead>
<tbody>
<tr>
<td>Australia</td>
</tr>
<tr>
<td>Austria</td>
</tr>
<tr>
<td>Belarus</td>
</tr>
<tr>
<td>Belgium</td>
</tr>
<tr>
<td>Brazil</td>
</tr>
<tr>
<td>Canada</td>
</tr>
<tr>
<td>China</td>
</tr>
<tr>
<td>Czech Republic</td>
</tr>
<tr>
<td>International Toll-Free Conference Numbers</td>
</tr>
<tr>
<td>-------------------------------------------</td>
</tr>
<tr>
<td>Denmark</td>
</tr>
<tr>
<td>Finland</td>
</tr>
<tr>
<td>France</td>
</tr>
</tbody>
</table>

Is there anything different about recording a meeting with Integrated Toll-Free?

Whether you or your attendees join with VoIP, toll or toll-free audio, you can easily and seamlessly record all participants. From the Recording section of the Preferences window, simply select **Use GoToMeeting Audio Service**. For more information about the Recording feature, please see [Recording a Meeting](#) on the GoToMeeting support site.

How can I cancel Integrated Toll-Free?

If you no longer require the Integrated Toll-Free service then please contact Global Customer support which is available 24/7.
Recording FAQs

Why can't I record?

To record a meeting, you must use a PC and have Windows Media Player 9 or above. You can download this for free at http://www.microsoft.com/windows/windowsmedia/default.aspx. Unfortunately, GoToMeeting does not support Mac recording at this time.

Can I record webcams during an HDFaces session?

Although you can record screen sharing and audio, you cannot record webcams at this time.

Why does my finished recording only display a blank screen?

To avoid a recorded meeting with a blank screen, please ensure the presenter initiates some type of screen action (such as advancing a presentation slide) after clicking the Start Recording button. If recording begins before the presenter shares his or her screen and there is no screen action then the finished recording will only include a blank screen and audio.

Can meeting attendees record a meeting using the GoToMeeting recording feature?

No, only PC-based meeting organizers or promoted organizers have access to the GoToMeeting recording feature.

How do I record a meeting with audio?

To record audio, an organizer must have a sound card installed on his or her computer. (If you can hear music played on your computer, you have a sound card.) If you are using GoToMeeting integrated audio, the audio you and your attendees transmit over the phone or VoIP (using a microphone connected to your computer) will be recorded automatically when you click the Start Recording button.

If you are recording a teleconference using an audio service other than GoToMeeting integrated audio, you can position the microphone next to the phone or set up a phone-recording adapter to your phone and line-in input on your computer's sound card. In addition, be sure that the Record Audio option is selected from the Recording category in your GoToMeeting Preferences.

How can I improve the quality of my meeting recordings?

The lower you set your monitor resolution, the better the quality of the meeting recording. We recommend a maximum resolution of 1024 x 768 for optimal recording quality. Also, it is best to view your recording in full-screen mode.

What happens if I click the Stop button in the Recording pane in the middle of a meeting and then resume recording?

The meeting recording stops when you click the Stop button in the Recording pane and resumes recording when you click the Start Recording button. However, a new file is not created for each recorded segment of the meeting; it is simply appended to the existing recording file. You will only have one recording file per meeting.

What happens if one of the presenters on my recorded meeting has a larger screen than I do?

The recording will have the dimensions of the largest screen presented during the meeting. The portions of a recorded meeting that show a smaller screen will display the image centered in the playback window with a black border around it.

How do I save my meeting recording?

Recordings are automatically saved to the path indicated under the Recording category in your GoToMeeting Preferences when you end or leave a meeting. Impromtu meetings will be named with the date and time plus the words "Meet Now," while scheduled meetings will include the meeting subject in
the file name. Note that you cannot change the location where you would like to save a recording once you have clicked the Start Recording button. If you cannot find your recording, check the path listed in the "Save in" pane of your Recording Preferences.

Where are my recorded meetings stored?

The default destination for recorded meetings is the My Documents folder. You can change the destination location only before recording begins. It is recommended that the designated location have a minimum of 1 GB of free space to accommodate the recording.

How do I play back a recorded meeting?

First you must end the meeting that you are recording. GoToMeeting will then automatically save your file with the meeting name you designated at the time of scheduling as well as the date and time. Impromptu meetings will be named with the date and time of the meeting followed by "Meet Now."

1. Navigate to the directory that is listed in the Save in: field under the Recording Preferences category.
2. Click the file name to start the replay.
3. Press Alt and Enter on your keyboard at the same time to maximize the Viewer Window for best replay quality.

*To view a meeting recorded in the GoToMeeting format, you must either have GoToMeeting installed, or download the GoToMeeting codec (GoToMeeting 2.0 decoder) at http://www.gotomeeting.com/codec.

**To view a meeting recorded in the Windows Media format, you will have to wait until the conversion process is complete. GoToMeeting converts the recorded meeting into a Windows Media Player file after the meeting is over so that the impact on CPU resources doesn't bog down the computer during the meeting. Allow time for the conversion to take place. The time needed is dependant upon video content, CPU speed and amount of memory available.

***Playing a recorded meeting back before ending the meeting may cause abnormal playback behavior. Be sure to end the meeting before playing it back.

When I play a recorded meeting, it plays back scrambled. Is there something I can do to fix this?

If you experience scrambled playback of a meeting recording, which can happen if the presenter used a multiple-monitor setup, you can try the following:

In Windows Media Player, go to the Tools menu and select Options. Click Advanced under the Performance tab. In the dialog that pops up, uncheck "use video mixing renderer." Click OK until you have dismissed all dialogs. Play the video again, and it should play unscrambled.

Can I edit a recorded meeting?

The GoToMeeting Recording and Meeting Playback feature allows you to record and preserve meetings as either a GoToMeeting video file or a .WMV file. If you wish to edit either file type you may need to first convert the file into an editable format with a program like Microsoft's Expression Encoder. Once converted, the file can be edited with the software of your choice. For more information on encoding your recordings please view Edit a Recorded Meeting.

What is the best way to distribute a recorded meeting?

If a meeting recording is small enough, you can distribute it as an email attachment. However, most recorded meetings will be too large for emailing. If this is the case, you may want to upload the file to a Web server for easy access. Remember that Mac-based viewers can only view meetings in the Windows Media Player format and that PC-based viewers must have GoToMeeting or the GoToMeeting 2.0 Video Codec installed to watch a recorded meeting created in the GoToMeeting format. The GoToMeeting 2.0 Video Codec is available to download for free at: http://www.gotomeeting.com/codec and can be distributed freely. Regardless of the format, all viewers must have Windows Media Player 9 or higher to view the recording.

What does GoToMeeting record?
GoToMeeting records the presenter's screen and the audio portion of the presentation. You can view chat records in the reports generated after your meeting is finished.

**Does recording cost me anything extra?**

GoToMeeting's recording feature is free and provided as a part of the service.

**About how large are the files going to be?**

File size is dependent on the individual screen settings but a good rule of thumb is around 1 MB per minute.

**How do I view recordings online?**

If you wish to share your video online you will need to host the video on your own network or with a 3rd party provider. GoToWebinar Corporate organizers can upload their videos to our servers for up to 12 months. PC users can also utilize Citrix Online's free online recording solution called GoView. Please visit www.goview.com to learn more.

**Can I record meetings in a non-WMV format?**

At this time, GoToMeeting can only output GoToMeeting's native recording format and WMV. To learn more about how to convert one of these file types please visit Edit a Recorded Meeting.

**How do I record a meeting?**

1. Click the View menu on the top of the GoToMeeting control panel and select Recording.
2. Click the Start Recording button.
3. When you end the meeting the recording will be saved to your My Documents folder.

**How do I review chat records and meeting attendance?**

PC users can have their chat logs automatically saved to a location of their choice. This feature is managed from the General tab in their Preferences window. Meeting history is stored on your account for 90 days (12 months for GoToMeeting Corporate.) To view your meeting history, please visit www.gotomeeting.com and log-in to your account. Click the My Meetings link and then click on the Meeting History link.

**Why can’t my attendees view my recorded meeting in Safari or Flip4Mac?**

If you experience problems playing recordings from Flip4Mac and/or Safari, we recommend pasting the video URL directly into QuickTime player. This can be done with the Open URL menu item in the File menu in QuickTime player.

**Troubleshoot Recording and Replaying a Meeting**

- **To troubleshoot recording and playback**
  - Please see the [Need audio help?](#) and [Learn more](#). These pages are also linked from the Recording category of the organizer Preferences menu.

**Citrix Presentation Server FAQs**

**Organizer FAQs**

Once I start a meeting, it runs on my local desktop. When I try to invite other attendees using the "Invite Others" option on the organizer Control Panel, GoToMeeting doesn't integrate with my published version of Outlook (or Lotus Notes). How can I resolve this?
You need to verify that the option selected in your GoToMeeting Preferences under the Integrations category matches the option selected in the Advanced section of the Integrations.

Attendee FAQs

When I am designated the presenter at a meeting, I can only show the applications that are published to me from Presentation Server and nothing that is on my local desktop. How can I present my local desktop?

Contact your Citrix Presentation Server Administrator about installing GoToMeeting on Presentation Server. By installing GoToMeeting and configuring the recommended settings on Presentation Server, all GoToMeeting sessions will be redirected to the desktop. Running a meeting on the local desktop enables you to present anything on your desktop.

Connection Test Help

Most connection-test difficulties are related to user-authentication issues. Please answer the question below to assist you with determining if this problem exists and which actions to take.

Did you see an Authentication Required dialog box containing three fields labeled Domain, User Name and Password?

- **Yes, I did see the dialog box and I believe I entered all the correct information but I am still having trouble.**
- **Yes, I did see the dialog box but the 'Domain' field was empty or may be incorrect.**
- **Yes, I did see the dialog box but the 'Domain' field was absent.**
- **No, I did not see the dialog box.**
- **Help, I followed the steps but I am still having trouble.**

Yes, I did see the dialog box and I believe I entered all the correct information but I am still having trouble.

The user name and password required here are the same as those that you use to log on to your Windows computer.

As when entering all user names and passwords, please make sure that:

- You are typing correctly, especially since you cannot see the password characters as you type them.
- Your Caps Lock key is off.
- You do not have any trailing white-space characters in the fields. Check this by deleting and retyping the entire contents of each field or by checking the end of each field for a blank space.

Yes, I did see the dialog box but the Domain field was empty or may be incorrect.

Our software will attempt to fill in the Domain field for you. In rare cases this may not work, and the Domain field will be blank or an incorrect Domain will be shown.

Yes, I did see the dialog box but the Domain field was missing.

This dialog box indicates that 'Basic Authentication' is in use on your web proxy. The User Name and the Password required here might be the same as those you use to log on to your Windows computer.
However, your web proxy may require different passwords than those you use to log on to your Windows computer. Your network administrator can confirm whether or not you have the correct information.

As when entering all user names and passwords, please make sure that:

- You are typing correctly, especially since you cannot see the password characters as you type them.
- Your Caps Lock key is off.
- You do not have any trailing white-space characters in the fields. Check this by deleting and retyping the entire contents of each field, or by checking the end of each field for a blank space.

**No, I did not see the dialog box.**

Please contact Global Customer Support.

**Help, I followed the steps but I am still having trouble.**

Please contact Global Customer Support.
Desktop Notifications

What is the Desktop Notifications feature?

Desktop Notifications is a free GoToMeeting feature designed to deliver simple and effortless access to complimentary Citrix Online software upgrades, information, news and discounts individual users may be eligible for. Desktop Notifications delivers information right to your desktop, allowing you to safely receive important product information that is relevant to you. Desktop Notifications are sent only by Citrix Online as a service to our customers.

How does it work?

Occasionally, when you are connected to the Internet, Desktop Notifications will automatically connect with Citrix Online servers to see if there are any new messages for you. If there are any messages for you, Desktop Notifications will display them on your computer screen.

Outlook Integration Troubleshooting

GoToMeeting is designed to integrate with the Microsoft Outlook program installed on your computer, allowing you to quickly and easily add GoToMeeting events to your Outlook calendar and invite people to your sessions in one smooth motion. If the invitation email does not launch after you schedule a meeting, or if the meeting does not get scheduled on your Outlook calendar, try the following steps.

- **Microsoft Outlook 2003**
- **Microsoft Outlook 2007**

To troubleshoot Outlook integration

1. Close Microsoft Outlook, if it is currently running.
2. Next, locate the icon in the system tray on your computer.
3. Right-click the 🌟 icon and click Preferences.

4. From the Preferences window, select Integrations in the left-hand menu.

5. Uncheck the box that says Use GoToMeeting with and click OK. This removes current integrations.

6. Right-click the ✰ icon in the system tray and click Preferences.

7. Select the Integrations category.

8. Re-check the box that says Use GoToMeeting with and ensure that Microsoft Outlook is selected.
9. Click **OK**.

10. Open Outlook.

11. The GoToMeeting Toolbar that allows scheduling of meetings from within Outlook should be present. If you see this toolbar, GoToMeeting should automatically launch invitations and add calendar entries to your Outlook calendar.

12. If you do not see the toolbar, or if scheduling a meeting still does not launch email invitations correctly, continue reading for instructions on enabling the GoToMeeting add-on within your version of Outlook.
Enabling Add-ins in Microsoft Outlook 2003

1. Open Outlook.
2. Click Help in the top menu and select About Microsoft Office Outlook.
3. Click Disabled Items.
4. Select the GoToMeeting Outlook COM Addin and click Enable.

Enabling Add-ins in Microsoft Outlook 2007

1. Open Outlook.
2. Click Tools.
3. Select Trust Center.
4. Click Add-ins. Under Manage in the menu below, select COM Add-ins and click Go.

5. In the COM Add-Ins section, check the box for the GoToMeeting Outlook COM Addin, and click OK.
Trouble Joining a Meeting

Test Your GoToMeeting Connection

You can easily test your connection with GoToMeeting before your organizer begins the meeting to ensure that you can join successfully. This allows you to make sure your computer has everything required to join a session. Simply click join a live session below to get started!

To test your GoToMeeting connection, join a live session with a customer support agent

- If you're launched into session and the GoToMeeting Control Panel and Viewer appear on your desktop, you've successfully joined the meeting! A live support representative will also be available to answer your questions between 5:00 AM and 4:00 PM PST.

- If you're unable to join the meeting, you may not have all the necessary software. Try checking Common Issues When Joining a GoToMeeting on a PC, Common Issues When Joining a GoToMeeting on a Mac or the GoToMeeting System Requirements for more information.
Common Issues When Joining Meetings on PCs

The following are some common issues that you may encounter when trying to connect to GoToMeeting on a PC. We've recommended a few easy ways you can resolve these issues.

Trouble joining a meeting?

If you're running into problems when trying to join a meeting, we highly recommend that you install the latest version of Java. To install the latest version of Java, visit Free Java Download. Many common issues can be easily resolved by updating or installing the latest version of Java.

Does your browser crash or freeze?

If you're trying to join a meeting and either your browser crashes or you see the error message below, we recommend that you uninstall your old version of Java and reinstall a newer version of Java. Uninstalling an older version of Java is optional but highly recommended for security reasons. Read Why should I remove older versions of Java from my system? for more information.

To uninstall or install Java on your PC

1. To uninstall Java on your PC, visit How do I uninstall Java on my Windows computer? Follow the directions.

2. Once you've uninstalled your old version of Java, you'll need to reinstall an updated version of Java. To install the latest version of Java, visit Free Java Download.

Can your installer not locate a suitable folder?
If you're trying to join a meeting from a PC and see "The installer could not locate a suitable folder to install into" error, try any of the following workarounds:

**On Windows XP:**
- **Install Java:** On Windows XP, you can visit [Free Java Download](#) to install the latest version of Java. After you've installed the most recent version of Java, you can seamlessly join sessions!
- **Use a Different Browser:** If you're using Internet Explorer, try joining the meeting using a different browser, such as Mozilla Firefox or Google Chrome.

**Windows Vista & Windows 7**

In rare cases, GoToMeeting may not install correctly if the Windows Secondary Logon Service is disabled. Follow the steps below to turn it on:

1. Click the Windows Start button on your desktop.

![services.msc search](#)

2. Type "services.msc" into the search field. Select the "services.msc" option from the search results.


4. On the Secondary Logon Properties dialog, select **Automatic** from the "Startup type" drop-down menu. Click **Apply**, and then click **OK**.
5. From the Services window, right-click the "Secondary Logon" option again, and click **Start**.
6. Restart your PC. You can now install GoToMeeting!

Do you see a "Connection Failed" error?

If GoToMeeting launches, but you see a "Connection Failed" error, you may either have security software on your PC that's blocking you from downloading GoToMeeting or have poor Internet connection. You may see the following error:

- **Security Firewall**: If you have security software on your PC that's preventing you from launching GoToMeeting, visit [Using GoToMeeting with a Firewall](#) for help on how to configure your firewall to allow GoToMeeting to launch.
- **Internet Connection**: Check to see if your Internet connection is down. See the [GoToMeeting System Requirements](#) for information on what type of Internet connection is required to host or join meetings. Satellite, dial-up and other non-broadband Internet connections do not meet our system requirements.
- **Firewall**: If you're using GoToMeeting in a corporate or network security environment, try running the [GoToMeeting Connection Wizard](#) to test and find the ideal connection settings you can use within your protected network.
- **Network Security Restriction**: If you're prompted to authenticate for Internet access, your network administrator may have placed restrictions. Enter your Windows or network login if prompted.

**Common Issues When Joining Meetings on Macs**

The following are some common issues that you may encounter when trying to connect to GoToMeeting on a Mac. We've recommended a few easy ways you can resolve these issues.

**Are you having problems using GoToMeeting on Mac OS X 10.5 (Leopard)?**
GoToMeeting isn’t supported on Safari if you’re running Java update 10 on Mac OS X 10.5 (Leopard). If you’re running Java update 10 and Mac OS X 10.5 (Leopard), we recommend using the latest version of Mozilla Firefox or Google Chrome to launch GoToMeeting. You won’t be able to launch GoToMeeting using Safari on OS X Leopard.

To install the latest version of Mozilla Firefox


2. Click Firefox Free Download to get the latest version of Firefox.

3. Once you’ve successfully installed Firefox, you may find it helpful to copy and paste the Join URL into Firefox’s address bar.

To install the latest version of Google Chrome


2. Click Download Google Chrome.

3. Once you’ve successfully installed Chrome, try joining the meeting. You may find it helpful to copy and paste the Join URL into Chrome’s address bar.

Does your web page display “Joining the meeting: Click Trust, Allow or Open if prompted” but nothing happens?

Most likely Java did not successfully load in your browser. Try to manually download GoToMeeting or troubleshoot your Java issues.
How do I find out if Java is working correctly?

1. Visit How do I test whether Java is working on my computer? to see if Java is working on your Mac.

2. If Java is working correctly, you'll see the message “Your Java is working”:

3. If you don't see “Your Java is working” or if you see an error, check to see if a Java update is available from Apple by clicking the Apple icon 🍎 in the top-left corner of your menu bar.

4. On your Mac, click the Apple icon 🍎 in the top-left corner of your menu bar, and select About This Mac.
5. See which version of Mac OS X you're running.

Visit Apple's website to download the most recent version of Java:

- Java for Mac OS X 10.5 (Leopard)
- Java for Mac OS X 10.6 (Snow Leopard)
- Java for Mac OS X 10.7 (Lion)

How do I join or host a meeting without having Java?

If you're using Mac OS X 10.5 (Leopard) or higher without Java enabled or installed, read Join or Host a Meeting Without Having Java to learn how to download and/or launch GoToMeeting.
Join or Host a Meeting Without Having Java on Your Mac

Join a Meeting - Attendee

Already have GoToMeeting installed on your Mac?

1. If you click the **Join a Meeting** button, GoToMeeting automatically detects if Java is disabled or not installed.

2. On the Join the Meeting page, enter the Meeting ID, and click **Continue**.

3. Since you already have GoToMeeting installed, click the **Join the Meeting** link in the "Already have GoToMeeting?" box.

4. When the Launch Application dialog appears, select "GoToMeeting," and click **OK**.

5. When GoToMeeting launches, you're prompted to enter your name and email (optional) as you'd like them to appear to other meeting attendees. Once you've done so, click **OK**.
Congratulations - you've successfully joined the meeting!

**Need to install GoToMeeting?**

1. If you click the **Join a Meeting** button, GoToMeeting automatically detects if Java is disabled or not installed.

2. On the Join the Meeting page, enter the Meeting ID, and click **Continue**.

3. Click the **Download GoToMeeting** button in the "Need to install GoToMeeting?" box.

4. On the "Opening GoToMeeting.dmg" dialog, select the "Save File" option, and click **OK**.
5. When the Downloads window appears, double-click the GoToMeeting.dmg file to open it.

6. Drag and drop the GoToMeeting daisy into the Applications folder.

7. Return to the Join the meeting page, and click the **Join the Meeting** button to attend the meeting.
Congratulations - you've successfully joined the meeting!

**Host a Meeting - Organizer**

*Already have GoToMeeting installed on your Mac?*

1. If you click the **Host a Meeting** button, GoToMeeting automatically detects if Java is disabled or not installed.

2. On the Start GoToMeeting page, click the **Launch GoToMeeting** link.

3. When the Launch Application dialog appears, select **GoToMeeting**, and click **OK**.
4. When a dialog appears asking if you want to meet right now or schedule a meeting for later, choose one of the options. When you're ready to start hosting your meeting, log in with your email address and password (if you haven't already done so), and launch GoToMeeting.

**Need to install GoToMeeting?**

1. If you want to host a meeting but don't already have GoToMeeting installed on your Mac, click the **Host a Meeting** button.

2. When you arrive on the Start GoToMeeting page, click the **Download GoToMeeting** button in the "Need to install GoToMeeting?" box.

3. An "Opening GoToMeeting.dmg" dialog appears on top of the Start GoToMeeting page, listing step-by-step instructions on how to install the GoToMeeting.dmg file. Select the "Save File" option, and click **OK**.
4. When the Downloads window appears, double-click the GoToMeeting.dmg file to open it.

5. Drag and drop the GoToMeeting daisy into the Applications folder.
6. Return to the Start GoToMeeting page, and click the **Launch GoToMeeting** button to open the application.
Troubleshooting Java Issues

If you're having problems with Java when trying to host or join a meeting, follow the steps below.

**On a PC:**

1. Uninstall Java on your PC by opening Windows Explorer and entering the following:
   - Windows XP - `%appdata%\sun\java\deployment\security`
   - Windows Vista & Windows 7 - `%userprofile%\AppData\LocalLow\Sun\Java\Deployment\security`

2. In the Java Deployment Security folder, delete the "trusted.certs" file.

![Java Deployment Security Folder](image)

**Note:** If you don't see the "trusted.certs" file, display hidden files on your computer. For instructions on how to display hidden files and folders, visit the following site suitable for your OS:

- [Windows XP](#)
- [Windows Vista](#)
- [Windows 7](#)

3. After you've successfully deleted the "trusted.certs" file, reinstall Java. For instructions on how to install Java on your PC, visit the [Java Downloads for All Operating Systems](#).

4. The next time you host or download a meeting, you'll be seamlessly launched into session!

**On a Mac:**

1. Open Finder, and click the Go drop-down menu. Select the Go to Folder option.

![Finder Go to Folder](image)

2. Enter `/System/Library/Java/Support/CoreDeploy.bundle/Contents/Home/lib/security/` in the "Go to the folder" pop up. Click Go.

© 2011 Citrix Online, LLC. All rights reserved.
3. Delete the "cacerts" file.

4. Install the latest version of Java on your Mac. Visit the Apple Support Download to install Java for your OS.

5. After you've successfully installed Java, you can now seamlessly host or join meetings!

Connection Wizard

The GoToMeeting Connection Wizard tests and determines the ideal connection settings GoToMeeting can make within your network. The Connection Wizard stores optimal connection settings on your computer and keeps these settings for future attempts to join or host a meeting from your computer. Advanced users and network administrators may wish to use the Custom Wizard.

Citrix does not currently offer Mac support for the GoToMeeting Connection Wizard.

To run the GoToMeeting Connection Wizard

1. To find our Connection Wizard, go to http://www.gotomeeting.com/wizard.

2. Click GoToMeeting Connection Wizard.

3. Click Save File to download the g2mwizard.exe file.

4. In the Downloads box double-click the file name.

5. Click Open or Run.

6. Once the Connection Wizard opens, click Run Wizard.
7. The Connection Wizard opens a browser window to the GoToMeeting website and attempts to detect connections to Citrix servers. Wait for the Connection Wizard to test connectivity, then click Next.

8. The Connection Wizard informs you if it finds good connection settings. Click Exit Wizard to finish.

Using the Custom Wizard (Advanced Users Only)

The Custom Wizard is for advanced users and network administrators to activate additional options to customize GoToMeeting connections within your network.
Citrix does not currently offer Mac support for the GoToMeeting Connection Wizard.

To run the GoToMeeting Custom Wizard

2. Click GoToMeeting Connection Wizard.
3. Click Save File to download the g2mwizard.exe file.
4. In the Downloads box double-click the file name.
5. Click Open or Run.
6. Once the Connection Wizard opens, right-click the GoToMeeting logo banner to activate additional options.

7. On the options menu, click Custom Wizard.
8. Specify the parameters of the connection test. If you'd like detailed information on the IP addresses of the data servers the wizard attempts to reach, please consult our IP range document, available at http://www.citrixonline.com/iprange.
9. When finished, click **Next**.

The Connection Wizard opens your browser to the GoToMeeting website.
10. Wait for the Connection Wizard to detect a connection to Citrix servers and click **Next**.

11. The Connection Wizard displays all verified connection methods. You can select a connection method and set its usage from the drop-down menu. You can force GoToMeeting to communicate through a specific port. If your network requires Internet traffic to go through a proxy and it is listed as a verified connection method for GoToMeeting, set its usage to **Force** or **Try Always**.
12. If there are no verified communication methods, or you do not see your network proxy listed, click **Add**.

13. Specify your proxy information and click **Verify** to test it. If the Connection Wizard cannot verify your network proxy connection settings, contact your network administrator or refer to our Citrix Online IP range (http://www.citrixonline.com/iprange) for optimal firewall configuration.

14. Once the Connection Wizard finishes, it notifies you of its results.

15. Attempt to restart the GoToMeeting program and determine if your connectivity has improved. If you find that you cannot connect on a given configuration, open the Connection Wizard again. Right-click the GoToMeeting logo banner. Click **Manual Tools**.

16. Click **Reset** to remove any previously stored settings.

17. Once settings have been reset, run the Connection Wizard again and see if you can join or host a meeting.